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Présentation de JUICE :

JUICE  est  développé  par  M.  Lubomir  Tichý,  chercheur  au  sein  de 
l'université Masaryk, à Brno (République Tchèque).

Bien que présenté de manière large comme « un programme de gestion, 
d'analyse  et  de  classification  de  données  écologiques »  dans  le  manuel 
d'utilisation  en  anglais  de  TICHÝ  &  HOLT  (2006  &  2011),  il  est  avant  tout 
destiné au traitement de données phytosociologiques. En effet, il permet une 
manipulation très facilitée des tableaux à travers une interface adaptée aux 
besoins spécifiques de l'étude de la végétation.

Au  côté  d'autres  logiciels  similaires  tels  que  GINKGO  (développé  par 
Miquel  De  Cáceres  au  sein  de  l'université de  Barcelone,  Espagne)  ou  de 
TABWIN (Dr.  Cord  Peppler-Lisbach  université  d'Oldenburg,  Allemagne)  et  en 
complément à TURBOVEG (Dr. Stefan Hennekens, université de Wageningen, 
Pays-Bas) JUICE est destiné à remplacer l'utilisation des tableurs comme outil 
de base pour le traitement des données relatives à la végétation.

La conduite de nombreuses analyses et de tests statistiques, finissent 
d'en faire un outil de travail efficace pour le phytosociologue.

Bien que ce logiciel soit programmé pour fonctionner nativement sous le 
système d'exploitation Microsoft Windows(R), il est possible de l'utiliser sous les 
systèmes  d'exploitation  Mascintosh  et  Linux,  par  exemple,  grâce  à  des 
« intermédiaires » tels que « PlayOnMac » ou « WINE ».

Le logiciel et son manuel d'utilisation officiel sont disponibles uniquement 
en langue anglaise. Le présent guide d'utilisation a pour objectif principal de 
combler le manque de documentation en langue française et ainsi encourager 
l'utilisation de ce logiciel en France (Cf. Carte en Annexe I).

Remarque :
Pour trouver le site officiel de JUICE dans un moteur de recherche sur Internet, 
un très bon résultat est obtenu en combinant «JUICE » et « Tichy », le seul mot 
clé « juicejuice » signifiant « jus » en anglais, le résultat pour ce seul terme est bien 
évidemment insatisfaisant.
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Présentation du guide et de ses objectifs :

Le  présent  ouvrage  était  au  départ  (en  avril  2009),  un  petit  tutoriel 
étudiant sans grande ambition d'une trentaine de pages écrit à la suite d'un 
stage en 3e année de licence (Cf. BECK 2008) et destiné à aider les camarades 
de classes à appréhender l'utilisation du logiciel. Il avait été mis en lien sur le 
site officiel de JUICE.

Le  professeur  Jan-Bernard  Bouzillé  de  l'université  de  Rennes  1,  qui 
proposait dors et déjà des indications pour l'utilisation de JUICE dans son livre 
« Gestion des habitats naturels et biodiversité », s'est proposé de reprendre 
l'écriture, afin de présenter les fonctionnalités plus complexes qui n'étaient pas 
abordées dans le tutoriel de 2009.

Ce document ayant vu sa taille augmenter considérablement suite aux 
apports du professeur Bouzillé, c'est un véritable guide d'utilisation que nous 
proposons aujourd'hui. 

Il doit permettre l'appréhension les principales fonctionnalités de JUICE. 
Pour  cela  il  présente  des  méthodes  simples  pour  réaliser  l'importation  de 
tableaux  phytosociologiques  bruts  (chapitre  I),  donne  des  indications  sur 
l'usage  de  la  souris  dans  le  logiciel,  propose  une  liste  exhaustive  des 
fonctionnalités  testées  (chapitre  II),  et  enfin  explique  comment  utiliser  la 
plupart  des  fonctions  listées  ainsi  que  certaines  des  principales  analyses 
statistiques  disponibles,  et  pour  finir,  comment  exporter  les  tableaux  de 
végétation vers d'autres logiciels.

Cependant nous avons choisi  de ne pas le faire  exhaustif.  M.  Tichý a 
développé de très nombreuses fonctions et ce document ne les présente pas 
toutes.  Nous avons choisi  de nous limiter  à  celles  qui  sont  utilisables  sans 
licence propriétaire de logiciel (il exclut donc, entre autre, l'usage de CANOCO). 
Certaines  fonctionnalités  très  complexes  ou  n'ayant  d'intérêt  que dans  une 
étude phytosociologique de grande ampleur ont également été exclues de ce 
guide d'utilisation.

Ce  document  est  susceptible  d'évoluer.  Pour  toute  suggestion  ou 
question,  merci  de  prendre  contact  à  l'adresse  suivante : 
beckflorent@gmail.com.

NB : Ce guide n'est pas une traduction du manuel d'utilisation de Tichý & Holt (2006),
il est une création originale en langue française.

Pour le manuel d'utilisation officiel reportez vous à :
JUICE program for management, analysis and classification of ecological data,

Tichý & Holt, 2006 [2nd Edition, 1st part, 2011]
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0.A Licence du document  

Ce document est diffusé sous licence Creative Commons by-nc-nd
Cela signifie que vous êtes libre de copier et de diffuser ce document, à condition d'en 

nommer les auteurs et à l'exclusion de tout usage commercial.
Toute modification par des tiers est soumise à autorisation préalable et ne saurait 

engager les auteurs.

Pour plus de détails, visitez : http://creativecommons.org/licenses/by-nc-nd/2.0/fr/

0.B Version du document  

À la date du 13/04/11, ce manuel se trouve dans sa version : 1.0
Vérifiez les mises à jour à l'adresse suivante :
http://european-flo.blogspot.com/2010/08/phytosociologie.html

0.C Convention graphique adoptée  

Des  termes  en  anglais  sont  repris  dans  ce  document  pour  une  plus 
grande  cohérence  entre  la  lecture  et  l'utilisation  du  logiciel.  Ceux-ci  sont 
généralement traduits une première fois afin d'en faciliter la compréhension 
pour les non-anglophones, mais par la suite souvent simplement donnés tels 
quels. Ils sont signalé par un texte en italique ombré et des guillemets :

« english termsenglish terms »

Les noms des menus, boutons et fonctions à utiliser dans le logiciel sont 
signalés  par  la  police  de  caractère  « DejaVu  Sans  Mono »,  un  sur-  et 
soulignement et un fond gris clair.

Menu : File

Bouton : Layer

Fonction : Copy WHITE releves to clipboard

Un enchaînement de menus et de sous-menus est signalé par l'utilisation 
de chevrons droits (>) :

Menu : FileFile     >  >     Import > Table > From TURBOVEG XML Format FileImport > Table > From TURBOVEG XML Format File    

Cette typographie est utilisée pour  signaler une interaction avec le 
logiciel.
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I Démarrage

I.A Installation  

Le logiciel est distribué gratuitement par son développeur :
Lubomir Tichý

Vous pouvez le télécharger légalement à l'adresse suivante :
http://www.sci.muni.cz/botany/JUICE/

I.A.1 Sous Microsoft Windows  

Vous  obtenez  un fichier  exécutable  Windows (format  *.exe)  qu'il  vous 
suffit de lancer pour procéder à l'installation. Pour la configuration minimale 
nécessaire et l'aide à l'installation, voir le site internet et le manuel d'utilisation 
en anglais [lien valide avril 2011].

I.A.2 Sous Macintosh  

Non testée

I.A.3 Sous Linux  

Le fonctionnement de JUICE sous Linux reste problématique mais n'est 
pas impossible.

Le fichier  exécutable Windows peut  être  lu grâce au logiciel  “ Wine ”. 
L'installation se déroule donc comme sous Windows. Dans la version 7.x de 
JUICE, l'exécutable pour TWINSPAN est inclus et lié de manière automatique. 
Pour l'instant aucune solution n'a été trouvée pour lier R (Voir Chap. III.B.3)

Installation testée avec succès sous les configurations suivantes :

• Ubuntu 9.10 /  wine1.2-gecko version 1.1.31-0ubuntu3 /  playonlinux 
version 3.6-1

NB : l'installation à l'aide de PlayOnLinux peut être simplifiée grâce à 
l'utilisation du script donné en Annexe   II  .

• Ubuntu 10.10 / wine version 1.2.2-1ubuntu1~maverick1

Dans les deux configurations proposées ci-dessus, JUICE fonctionne mais 
travaille  « au  ralenti ».  Ce  problème  n'a  malheureusement  pas  encore  été 
résolu.

• Fedora 14 / wine version 1.3.16-1.fc14 (i686)

JUICE fonctionne au ralenti et de gros problèmes d'affichages rendent son 
utilisation quasiment impossible dans cette configuration.
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I.B Import d'un tableau brut  

JUICE ne supporte pas la numérisation des données phytosociologiques, 
celles-ci doivent être importées depuis un autre logiciel (tableur, TURBOVEG ou 
bloc-note).

I.B.1 À partir d'un fichier Microsoft Excel  (R)  

Pour  procéder  à  cette  opération  il  faut  considérer  qu’un  tableau  brut 
classique de relevés   (comme l’exemple  fourni  ci-dessous),  comprend deux 
parties :

1- des informations relatives aux relevés floristiques (numéro, surface, 
recouvrement…) constituant les « HeaderHeader  DataData » (données de tête) ;

2- la matrice proprement dite des relevés composée des espèces et des 
coefficients d’abondance-recouvrement.

Numéro du relevé 1 2 3 4 5

Surface (en m2) 10 10 10 5 10
Recouvrement (en %) 80 100 80 100 80
Nombre d’espèces 11 8 5 10 8
Juncus gerardi 1 2 3 1
Parapholis strigosa 2 + 3 + 1
Hordeum marinum 1 2 2
Alopecurus bulbosus 1 2 3
Agrostis stolonifera 2 + 1

L’import du tableau doit être effectué en deux étapes en commençant par 
l’import de la matrice des relevés. Pour cela il convient de préparer le fichier 
Excel pour qu’il soit compatible avec le logiciel JUICE.

1.a Import de la matrice des relevés

Préparation du fichier Excel

Dans un premier temps il ne faut coller dans un nouveau fichier Excel que la 
matrice  des  relevés  (strictement  sélectionnée  pour  éviter  d’éventuels 
« parasites »  dans  des  cellules  extérieures  au  tableau).  Ensuite,  il  convient 
d’ajouter  un  titre  au  tableau,  de  préciser  l’entrée  générale,  par  exemple 
«Numéro des relevés» (ou une autre formulation), d’indiquer les numéros des 
colonnes. Ainsi, le tableau précédent doit se présenter comme ci-dessous :

Tableau relevés Juncus gerardi
Numéro des relevés 1 2 3 4 5
Juncus gerardi 1 2 3 1
Parapholis strigosa 2 + 3 + 1
Hordeum marinum 1 2 2
Alopecurus bulbosus 1 2 3
Agrostis stolonifera 2 + 1

Page 10 / 97

Matrice des 
relevés

Header Data



Ensuite, il faut l’enregistrer sous un format compatible avec JUICE. Pour cela, 
il faut, dans le menu « Edition » de Excel, cliquer sur « enregistrer sous », ce 
qui ouvre une nouvelle fenêtre qui va permettre de choisir le « type de fichier » 
dans le menu déroulant situé en bas de la fenêtre. Il  faut retenir un fichier 
« csv », ce qui correspond à l’option « CSV (séparateur : point-virgule)(*.csv) ». 
Avant d’enregistrer vous pouvez attribuer un nom de fichier qui vous convient 
pour le retrouver ensuite facilement quant vous allez avoir à l’importer. 

Importation de la matrice de relevés

Il faut revenir au logiciel JUICE, cliquer sur le menu File, puis choisir l’option 
Import suivie de  table et  enfin cliquer sur  from Spreadsheet File (ce qui 
correspond à une option de tableur). 

Une fenêtre intitulée IMPORT TABLE s’ouvre ; il faut rechercher dans le menu 
déroulant « Regarder dans » (parcourir) le fichier ou le dossier dans lequel vous 
avez enregistré votre tableau au format « CSV ». Il faut ensuite cliquer sur le 
fichier  correspondant  de manière  à ce que son nom s’affiche  en bas de la 
fenêtre, puis cliquer sur « Ouvrir ». 

Une nouvelle fenêtre apparaît : Import Manager For Spreadsheet Format 
File (Step 1/7) avec le titre de « Table fileTable file ». En cliquant par étapes sur Next 
situé en bas de la fenêtre, plusieurs informations sont proposées. Il convient de 
les vérifier avec attention à chaque étape. Lors de l’étape intitulée «  LayerLayer  
InformationInformation »  il  est  demandé  si  l’utilisateur  souhaite  que  dans  un  tableau 
ultérieur  figure  une  colonne  indiquant  la  strate  à  laquelle  appartient  une 
espèce du relevé (arborescente, arbustive, etc.).

La dernière étape consacrée à « CoverCover  ValueValue » demande de convertir les 
coefficients  d’abondance-dominance  en  pourcentages  moyens  de 
recouvrement. Il  importe de faire cette opération pour que le logiciel puisse 
ensuite poursuivre la gestion des données. Le manuel d’accompagnement de 
JUICE  propose  les  pourcentages  suivants  en  correspondance  avec  chaque 
coefficient :

. =  0%
r =  1%
+ =  2%
1 =  3%
2 = 13%
3 = 38%
4 = 63%
5 = 88%

Dans « Cover valuesCover values », en cochant  Braun-Blanquet Codes l’opération de 
conversion se réalise en principe automatiquement. Si tel n’est pas le cas, pour 
effectuer  cette  opération,  il  faut  cliquer  deux  fois  sur  le  coefficient  de  la 
fenêtre,  remplacer  le  chiffre  qui  apparaît  dans  la  petite  fenêtre  par  le 
pourcentage  correspondant  au  coefficient,  par  exemple  1 %  pour  r,  puis 
valider, et ainsi de suite. 

Pour terminer, en cliquant sur Finish, le tableau brut de relevés apparaît à 
l’écran sous sa forme initiale, c’est-à-dire avec les coefficients d’abondance-
dominance. Les conversions qui viennent d’être faites seront utilisées dans le 
cadre du traitement des données. 
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Remarques     :  
Si lors de ces opérations des messages de problèmes sont mentionnés, il 

faut revenir aux tableaux ayant fait l’objet de préparations avec Excel car c’est 
certainement  là  que se  posent  les  (ou  le)  problèmes  tels  qu’un  chiffre  qui 
manque dans une cellule du tableur Excel, ou un chiffre ou une valeur erronée, 
etc.

A ce stade il est fortement conseillé de sauvegarder le tableau importé, de 
manière à ne pas avoir à recommencer l’ensemble des opérations précédentes. 
Pour cela, cliquez sur le menu File, choisissez Save, nommez le fichier à votre 
convenance et enregistrez le dans le dossier en cours ou dans un autre dossier 
de travail affecté tout particulièrement à la végétation étudiée. 

1.b Import des « Header Data ». 

Là aussi il convient auparavant de préparer le fichier Excel.

Préparation du fichier Excel

Cette fois  il  faut coller dans un nouveau fichier Excel que les « HeaderHeader   
DataData ». Mais, il faut effectuer un collage spécial en choisissant transposer. 
De plus et SURTOUT il  faut remplacer « Numéro des relevés » par « ReleveReleve   
numbernumber » sinon l’opération échouera au moment de l’importation. Comme pour 
la matrice des relevés il faut enregistrer sous un format « CSV ».

Le tableau excel « Header Data » doit donc se présenter selon le schéma ci-
dessous.
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Releve number Surface (en m2) Recouvrement (en %) Nombre d’espèces
1 10 80 11
2 10 100 8
3 10 80 5
4 5 100 10
5 10 80 8

Importation des «     Header Data     »  

En revenant à JUICE, il faut à nouveau cliquer sur le menu déroulant File, 
puis cette fois choisir l’option  Header Data et cliquer sur  From Semi-Colon 
Delimited File. 

Comme précédemment pour la matrice des relevés, une fenêtre s’ouvre et il 
faut alors rechercher dans le menu déroulant « Regarder dans » (parcourir) le 
fichier ou le dossier dans lequel vous avez enregistré votre tableau « HeaderHeader   
DataData » au format « CSV ». Il faut ensuite cliquer sur le fichier correspondant de 
manière à ce que son nom s’affiche  en bas de la  fenêtre,  puis  cliquer sur 
« Ouvrir ». L’importation se fait alors automatiquement.

Pour vérifier que l’opération est réussie, cliquer sur le menu Head, puis sur 
Extended  Head.  Doit  alors  apparaître  à  l’écran  un  tableau  se  présentant 
comme ci-dessous.

Pour  revenir  au  tableau  de  relevés  il  suffit  de  cliquer  à  nouveau  sur 
Extended Head.

Remarque     :  
L’exemple considéré ici se limite à quelques informations mais il est tout à 

fait possible d’en intégrer beaucoup d’autres telles que les dates de réalisation 
des relevés, les coordonnées géographiques des relevés, etc.
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I.B.2 À partir d'un fichier Cornell Condensed (logiciel   
TURBOVEG, format .cc!)

Le logiciel  TURBOVEG permet l'élaboration (numérisation) de bases de 
données phytosociologiques.

Il  est  développé par  le  chercheur  néerlandais  Stephan Hennekens  ;  il 
fonctionne sous système d'exploitation Microsoft Windows(R) et est disponible 
en langue anglaise. Une  licence  utilisateur  peut  être  délivrée  à  titre 
gracieux pour  :  les  étudiants,  un  usage privé  ou  les  instituts  ou  université 
n'ayant pas les moyens financiers nécessaires.

Voir  :  http://www.synbiosys.alterra.nl/TURBOVEG/ section  « PricesPrices »  et 
contactez M. Hennekens.

NB : TURBOVEG peut également être installé sous Linux en utilisant la 
même technique qu'avec JUICE. Voir le Chap. I.A.3.

2.a Créez votre base de donnée :

Ouvrez le logiciel TURBOVEG, dans le menu Database choisissez New puis 
renseignez le nom de fichier dans « Database nameDatabase name » et dans le cadre « RangeRange  
of releves numbersof releves numbers » indiquez intervalle dans lequel doivent être compris les 
numéros des relevés (en général de 1 à n).

2.b Entrez vos relevés :

Dans la fenêtre « Database : Nom_de_votre_baseDatabase : Nom_de_votre_base » cliquez sur Add a new 
releve (2e icône en partant de la gauche) :

Dans  la  fenêtre  qui  s'affiche  alors,  renseignez  le  champ obligatoire  : 
Cover abundance scaleCover abundance scale.

Il y a plusieurs systèmes de codification de l'abondance ou dominance 
utilisés internationalement comme « DominDomin  » aux États-Unis, « ordinate scaleordinate scale » 
aux Pays-Bas, mais on peut aussi entrer des données en pourcentage, etc. Le 
plus souvent c'est l'indice classique de « Braun-Blanquet (old)Braun-Blanquet (old) » qui est utilisé 
et cela correspond au code 01.

Pour terminer, cliquez sur le bouton SaveSave.
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Une seconde fenêtre s'affiche grâce à laquelle on peut rentrer le premier 
relevé.

A droite se trouve la liste des espèces disponibles (dépend de la liste de 
travail -par pays- que vous avez demandée avec la licence). Il suffit de taper au 
clavier les trois premières lettres des noms de genre et d'espèce de l'espèce 
que  vous  recherchez  pour  la  trouver.  (e.g.  :  tapez  ''fag  syl''  pour  Fagus 
sylvatica)

Figure ci-dessus :   Fenêtre d'édition des informations d'un relevé dans le   
logiciel TURBOVEG

Dans l'onglet déroulant LayerLayer sélectionner la strate correspondante, puis 
dans la case CoverCover indiquez votre indice de recouvrement, enfin cliquez sur le 
bouton Add >>Add >>

NB : une même espèce peut être ajoutée plusieurs fois dans un relevé 
en la sélectionnant à nouveau et en indiquant des strates différentes.
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Une fois que toutes les espèces du relevé ont été entrées, cliquez sur 
SaveSave.

Pour entrer  les  relevés suivant,  recommencez la manipulation (cliquez 
successivement  sur  OuiOui et  sur  SaveSave dans  les  deux  premières  fenêtre  qui 
s'affichent, puis entrez votre relevé et sauvegardez en cliquant à nouveau sur 
SaveSave.

NB : il ne vous est pas demandé le numéro du relevé, le logiciel enregistre les 
relevés dans l'ordre ordinal. Vous ne pouvez donc pas renseigner le relevé 1 

puis le relevé 3 puis le relevé 2. Cependant vous pouvez à tout moment 
revenir sur un relevé renseigné précedemment et y effectuer des 

modifications.

2.c Exportez la base au format Cornell Condensed (.cc!) :

Lorsque vous avez fini d'enregistrer vos relevés, faites un clic droit sur 
l'un  d'entre  eux  dans  la  fenêtre  « Database  :  Nom_de_votre_baseDatabase  :  Nom_de_votre_base »  et 
choisissez  Select  all  releves  in  current  databaseSelect  all  releves  in  current  database :  ceux-ci  seront 
surlignés en jaune.

Figure   ci-dessus   :   Sélection des relevés avant export dans le logiciel   
TURBOVEG

Dans la fenêtre principale, cliquez sur  ExportExport puis  Cornell condensedCornell condensed  
species filespecies file, dans la fenêtre qui s'affiche, choisissez le dossier dans lequel 
votre fichier .cc! doit être exporté (Target directory) et le nom de ce fichier. NE 
TOUCHEZ  A  AUCUN  AUTRE  PARAMETRE,  cliquez  simplement  sur  le  bouton 
ExportExport.
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2.d Exportez la liste des abréviations

Cette étape est indispensable car le fichier .cc! ne transmettra les noms 
des espèces  qu'en abrégé à JUICE. Ce dernier a donc besoin de cette liste 
pour réattribuer son nom correct à chaque espèce.

Vos  deux  relevés  sont  normalement  toujours  sélectionnés  (et  donc 
surlignés  en jaune).  Dans  la  fenêtre  principale  cliquez  sur  ExportExport puis  sur 
Species check listSpecies check list. Une fenêtre s'ouvre. Choisissez le dossier de travail que 
vous souhaitez (« Target directoryTarget directory »). Il est conseillé de ne pas modifier le nom 
proposé par défaut (checklst.txt) et de sauvegarder ce fichier dans le dossier 
où est installé JUICE (probablement : C:\Program Files\JUICE).

Dans le cadre « Format output fileFormat output file » sélectionnez  SDF (fixed length)SDF (fixed length)  
puis cliquez sur le bouton ExportExport.

Vous  pouvez  à  présent  fermer  TURBOVEG  (la  sauvegarde  des 
informations est automatique).

2.e Import de la table brute dans JUICE

Ouvrez  JUICE,  allez  dans  le  menu  File > Import > Table > FromFile > Import > Table > From  
TURBOVEG or Cornell Condensed FileTURBOVEG or Cornell Condensed File, ou utilisez simplement le raccourcis 
clavier « Ctrl+T ».

Une fenêtre de navigation apparaît, sélectionnez le fichier *.cc! que vous 
avez exporté depuis TURBOVEG.

Une fenêtre  de  paramétrage de JUICE s'ouvre  :  «  Import  Manager  forImport  Manager  for   
TURBOVEG or Cornell Condensed File (Step 1/5)TURBOVEG or Cornell Condensed File (Step 1/5)  », cliquez sur le bouton Next >Next >

Vous passez au stade 2 (Step 2/5Step 2/5 - en haut à droite).

NE  CHANGEZ  RIEN  !  Le  paramètre  «  AbreviationsAbreviations  »  devrait  être  par 
défaut sur «  7+1 (layer)7+1 (layer)  » et le paramètre «  ScaleScale  » devrait être par défaut sur 
«  PercentagePercentage  ». C'est ce qu'on souhaite !
Cliquez sur Next >Next >
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Vous passez au stade 3 ; indiquez à JUICE où se trouve la fichier d'export 
de la liste des abréviations : cochez la case  Use check listUse check list et cliquez sur 
Append new check listAppend new check list.

La fenêtre d'option de JUICE s'ouvre à l'onglet «  Check List ImportCheck List Import  ». Dans 
le cadre «  File formatFile format  » sélectionnez Fixed lengthFixed length et dans le cadre «  FieldsFields  » 
sélectionnez ID Number, Abbrev., Spec. NameID Number, Abbrev., Spec. Name. Cliquez sur Open new checkOpen new check  
list  filelist  file et  sélectionnez  votre  fichier  (qui  doit  normalement  s'appeler 
« checklst.txt » et être rangé dans C:\Program Files\JUICE, si vous avez suivi les 
précédentes recommandations). Cliquez sur le bouton  Test file structureTest file structure  
puis sur OKOK et enfin sur Next >Next >.

Le stade 4 n'est pas documenté ici. Passez simplement au stade 5.

Votre table a du être correctement importée dans JUICE (c'est le « stade 
5 » : « Step 5/5 »). Vous pouvez commencer à travailler dessus.

NB : Dès maintenant, pensez à sauvegarder votre travail !
Menu : File > SaveFile > Save  ou  le raccourcis-clavier: Ctrl+S, choisissez votre 

dossier de travail et le nom du fichier, celui-ci portera l'extention JUICE : 
''*.wct''.
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I.B.3 À partir d'un fichier XML (logiciel TURBOVEG, format .xml)  

Dans TURBOVEG, après avoir ouvert une base de données correspondant 
à  un  tableau phytosociologique,  il  faut  d’abord sélectionner  l’ensemble  des 
relevés  (ou  une  partie  seulement  en  fonction  de  l’analyse  que  l’on  désire 
effectuer). Pour cela, dans la fenêtre principale, allez dans le menu SelectSelect puis 
Select all releves in current databaseSelect all releves in current database (les relevés seront surlignés en 
jaune).

Ensuite,  il  faut aller  dans le menu  ExportExport,  puis  choisir  Standard XMLStandard XML  
filefile. Une fenêtre s’ouvre où il faut indiquer :

• dans « Target directoryTarget directory » l’emplacement du fichier qui va être exporté (il 
est possible d’agir sur le bouton à droite pour faciliter l’opération) ; 

• dans « Output fileOutput file » le nom du fichier exporté (en veillant à ce que le 
l’extension *.xml soit bien indiquée, la réécrire si nécessaire).

Dans JUICE, allez dans le menu  FileFile, allez à  Import > Table > FromImport > Table > From  
TURBOVEG XML Format FileTURBOVEG XML Format File. Une fenêtre de navigation apparaît, sélectionnez 
le fichier .xml que vous avez exporté depuis TURBOVEG. Le tableau apparaît 
immédiatement à l’écran et une fenêtre invite à intégrer dans les « HeaderHeader   
datadata » les paramètres qui étaient présents dans la base de données TURBOVEG 
(Cf. figure ci-dessous). Pour cela, il faut cliquer sur le paramètre puis sur AddAdd, 
ou sur Add all fieldsAdd all fields si l’on désire intégrer tous les paramètres. En cliquant 
sur FinishFinish l’ensemble des données est importée dans JUICE.
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I.B.4 À partir d'un fichier texte (logiciel bloc-note, format .txt)  

Il faut rédiger (ou coller depuis un tableur) le tableau dans un logiciel de 
bloc-note (type WordPad, Bloc-Notes). La structure à suivre est simple :
➢ Commencer le tableau dès la première ligne (sans sauter de ligne, ni insérer 

de titre, ni de numéros de relevés).
➢ Chaque ligne correspond à une espèce.
➢ Le fichier doit être articulé en 3 colonnes :

1. le nom de l'espèce
2. le numéro de la strate
3. l'indice de recouvrement

➢ Chaque  colonne  doit  être  séparée  par  des  espaces  (au moins 5 entre 
chaque colonne), les colonnes n'ont pas besoin d'être placées les unes au 
dessus des autres. Cela n'est cependant pas déconseillé afin d'améliorer la 
lisibilité du tableau.

Figure ci-dessus     :   structure correcte du tableau dans un bloc-notes  

Figure ci-dessus     :   structure correcte du tableau dans un bloc-notes  
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Le numéro de strate doit être renseigné comme suit :
1 = state arborescente haute
2 = strate arborescente moyenne
3 = strate arborescente basse

Si vous n'avez pas de considération haut/moyen/bas, indiquez simplement : 1
4 = strate arbustive haute
5 = strate arbustive basse

Si vous n'avez pas de considération haut/bas, indiquez simplement : 4
6 = strate herbacée
7 = juvéniles (plus de 1 an)
8 = plantule (moins de 1 an)
9 = strate muscinale
0 = strate non renseignée

La manière d'indiquer l'indice de recouvrement est  relativement libre. 
Dans le doute, il est tout de même recommandable d'utiliser les échelles de 
Braun-Blanquet.

Les indices de recouvrement doivent être indiqués pour chaque relevé, 
lorsque l'espèce est absente du relevé, signalez le en remplaçant l'indice de 
recouvrement par un point « . », si  cette structure n'est pas respecté votre 
tableau sera faussé !

NB : on peut indiquer simplement la présence ou l'absence
de l'espèce dans le relevé avec ''1'' et ''.''

Acer campestre s. campestre     1     +11.11.
Cette ligne signifie donc que l'espèce « Acer campestre s. campestre » 

[insertion de 5 espaces au minimum] située dans la strate arborscente haute 
(signalée par le premier nombre « 1 ») [insertion de 5 espaces au minimum] 
apparaît dans : le relevé n°1 avec l'indice de recouvrement « + », dans les 
relevés n° 2, 3, 5 et 6 avec l'indice de recouvrement « 1 », et n'apparaît pas 
dans les relevés 4 et 7 (signalés par un point : « . »)

Le  fichier  au  format  *.txt  doit  être  obligatoirement  accompagné  d'un 
autre  fichier  texte  (réalisable  avec  le  même logiciel)  mais  au  format  *.tab 
(écrire simplement *.tab à la fin du nom du fichier). Ce fichier .tab contient la 
liste  des  numéros  des  relevés.  Chaque  ligne  correspond  à  un  numéro,  ils 
doivent être placés dans le même ordre que dans les indices de recouvrement 
dans le fichier *.txt.
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Figure ci-dessus :   Fichier au format *.tab, contenant les numéros des relevés.  

Le  nom  des  deux  fichier  *.txt  et  *.tab  doivent  être  rigoureusement 
identiques.  Ils  doivent  être  placés dans  le  même dossier  lors  du processus 
d'import dans JUICE.

Processus d'import : 
Ouvrir le logiciel JUICE :
Menu : File > Import > Table > From Simple Texte FileFile > Import > Table > From Simple Texte File
Une fenêtre de recherche s'affiche, parcourez votre dossier de travail et 

selectionnez le fichier au format *.txt.

La table s'affiche en arrière plan, tandis qu'une fenêtre au premier plan 
vous  invite  à  procéder  au  paramétrage  de  l'indice  de  recouvrement.  NE 
SAUTEZ PAS CETTE ETAPE, sinon vous vous retrouverez avec un tableau vide !
Cette  fenêtre  affiche  deux  colonnes,  la  première  contient  des  valeurs  de 
pourcentage,  la  deuxième correspond aux  symboles  que  vous  avez  utilisés 
pour renseigner vos indices de recouvrement.

Pour ajuster cette échelle, cliquez sur la ligne à modifier et indiquez si 
besoin, pour chaque symbole, le taux de recouvrement associé (exprimé en 
pourcentage).

Quand  vous  avez  fini  cliquez  sur  Continue >>>Continue >>> (et  surtout  pas  sur 
« CancelCancel » ce qui annulerait tout) !

Votre tableau est prêt, vous pouvez commencer à travailler dessus.
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II Prise en main

Pour ouvrir un tableau phytosociologique dans JUICE, dans le menu FileFile  
choisissez OpenOpen ou utilisez le raccourcis clavier : Ctrl+O.

Voilà à quoi devrait ressembler votre écran à présent : (l'exemple suivant 
est constitué par un tableau brut comportant 50 espèces réparties au sein de 
136 relevés).

Figure ci-dessus :   Les différentes zones d'affichage dans la fenêtre principale   
de JUICE
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Zone des «     Données de   tête     » (  Header Data  ) : Zone   T  
contient les informations décrivant les relevés (en général : leur numéro)

Zone d' «     affichage     » : ZONE   A  
contient  les  informations décrivant  le  rapport  entre une espèce et  un 

relevé  (en  général  :  le  coefficient  d'abondance/dominance  ou  un  indice  de 
présence/absence ou un indice de fréquence, par exemple lors de l'affichage de 
tables synoptiques)

Zone des «     données     » : ZONE   D   (bande grisée entre les zones A et E)
contient  des  informations  additionnelles  caractérisant  les  espèces  (en 

général : leur strate ou bien la valeur d'un des Indices d'Ellenberg)

Zone «     liste des   espèces     » : ZONE   E  
contient uniquement la liste des espèces

II.A Boutons et manipulation à la souris  

Il s'agit de déplacer des relevés ou des espèces les un(e)s par rapport 
aux autres, d'attribuer des couleurs à des espèces ou à des relevés, d'agréger 
des espèces et des relevés en blocs, insérer des séparateurs entre ces blocs, 
etc.

II.A.1 Zone de gauche : Affichage  

–  « openopen » Ouvrir un fichier de travail JUICE (format *.wct).

–  « savesave » Sauvegarder le travail en cours dans un fichier au format *.wct.
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–  « decrease & increase charactersdecrease & increase characters » servent respectivement à réduire 
la taille du texte dans la zone de travail (intéressant quand on manipule de 
grandes bases de données) et à agrandir la taille du texte dans la zone de 
travail (intéressant pour lire les informations qui s'y trouvent).

–  « go back to the tablego back to the table » permet de sortir de l'affichage des informations 

obtenues dans le menu «  Synoptic TableSynoptic Table  » et de retrouver les informations 
d'abondance/dominance.

–  « headhead » Affiche  et  masque  les  informations  contenues  dans  les 
«  Header DataHeader Data  », (voir à ce sujet le chapitre   II.C.6.  ).

–  « find speciesfind species » Affiche le bandeau de recherche d'une espèce (en bas 
de  l'écran  à  gauche,  l'autre  gauche,  oui,  là)  il  suffit  alors  de  taper  les 
premières lettres du nom de l'espèce et d'appuyer sur la touche « Entrée » 
pour  que  JUICE  fasse  défiler  la  liste  des  espèces  jusqu'à  ce  qu'un  nom 
correspondant à votre recherche s'affiche en haut de cette liste, surlignée 
en gris (NB : cela ne modifie pas l'ordre de rangement des espèces dans la 
liste : la fenêtre défile simplement jusqu'à l'espèce recherchée). Appuyez à 
nouveau sur la touche « Entrée » pour passer à l'espèce suivante contenant 
les mêmes lettres.

–  « layerlayer » Affiche la strate occupée par chaque espèce dans la zone  D 
(zone en grisée).

II.A.2 Zone de paramétrage des couleurs des espèces   

– La case dans laquelle il  est écrit « speciesspecies » indique la couleur principale 
actuellement utilisée pour colorier une espèce.

– Pour colorier une espèce faites un clic-droit sur la ligne correspondante.

– Pour  changer  la  couleur  principale  avec  laquelle  vous  voulez  travailler, 
cliquez dans la case speciesspecies pour passer à la couleur suivante ou cliquez 
directement sur le rectangle de la couleur de votre choix ou sélectionnez-la 
dans le menu déroulant.

– Vous  pouvez  regrouper  côte  à  côtes  plusieurs  espèces  coloriées  dans  la 
même couleur en cliquant sur les flèches « haut » et « bas »  dans la zone 
de paramétrage des couleurs  Gather species of the selected colourGather species of the selected colour  
towards the bottom/the toptowards the bottom/the top  . Cela déplace et regroupe toutes les 
espèces  ainsi  sélectionnées  par  leur  (même)  couleur  (et  qui  doit  être 
actuellement la couleur principale de travail) jusqu'à l'espèce située le plus 
en haut ou le plus en bas dans la liste.
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– La case « <Ctrl><Ctrl> » correspond à la couleur secondaire de travail.

– Pour colorier une espèce avec la couleur secondaire, maintenir la touche 
« Ctrl » du clavier enfoncée et faire un clic-droit sur la ligne correspondante. 
Au  lieu  d'être  coloriée  avec  la  couleur  principale,  l'espèce  choisie  sera 
coloriée avec la couleur secondaire.

– Vous pouvez modifier la  couleur secondaire avec laquelle vous souhaitez 
travailler en cliquant dans la case <Ctrl><Ctrl> ce qui la changera vers la couleur 
suivante  ou  en  enfonçant  la  touche  « Ctrl »  du  clavier  et  en  cliquant 
simultanément sur la couleur désirée dans la barre des couleurs.

– Le bouton Sort speciesSort species  permet de trier les espèces (toutes les espèces 
ou seulement les  espèces d'une couleur définie,  en fonction de tous les 
relevés  ou  en  fonction  des  relevés  d'une  couleur  définie).  Cf.  « SortSort   
SpeciesSpecies » Chap. II.C.7..

–  Merge speciesMerge species et  Divide speciesDivide species,  « merge speciesmerge species » (fusionner) 
permet  de  réunir  des  lignes  ayant  pour  entrée  la  même espèce ou des 
synonymes ; ce qui peut arriver lors de l'élaboration de la base de données 
ou  quand  on  regroupe  des  tableaux  d'origine  différente.  Pour  « dividedivide   
speciesspecies » en  D (dominant) ou  r (rare) cela permet de distinguer sur deux 
lignes du tableau les deux situations et donc de mieux repérer les relevés 
concernés.

–  Le  bouton  Reset  selected  species  coloursReset  selected  species  colours permet  d'effacer  la 
couleur  (colorie  en  noir)  les  espèces  coloriée  avec  la  couleur  principale 
actuelle de travail (clic simple), ou de supprimer toutes les informations de 
couleurs des espèces (colorie tout en noir) (double clic).

II.A.3 Zone de paramétrage des couleurs des relevés  

Fonctionnement analogue à celui de la zone « speciesspecies ». Pour colorier un 
relevé, faites un clic-droit au dessus du numéro de relevé correspondant (dans 
la zone des « Header DataHeader Data », au dessus des indices de recouvrement).
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II.A.4 Zone de paramétrage des séparateurs  

Vous pouvez insérer des séparateurs (lignes verticales ou horizontales) 
entre les relevés et les espèces. Pour cela, utilisez le bouton « MAJ » (Shift) de 
votre clavier et cliquer simultanément au-dessus du numéro de relevé, à droite 
duquel  vous  souhaitez  insérer  un  séparateur.  (Re-cliquez  -toujours  en 
enfonçant la touche « MAJ »- pour effacer ce même séparateur). Procédez de 
même : « MAJ+clic » sur la ligne d'une espèce pour insérer un séparateur en 
dessous.

– Si  la  case  Separator  hierarchySeparator  hierarchy est  cochée,  vous  avez  la  possibilité 
d'insérer  différents  types  de  séparateurs  afin  de  réaliser  une  hiérarchie 
entre  vos  différents  groupes.  Pour  insérer  des  séparateurs  du niveau de 
hiérarchie souhaité, sélectionner celui ci dans le menu déroulant.

–  le bouton Reset separatorsReset separators permet d'effacer tous les séparateurs mis 
en place.

NB : JUICE traite les relevés/les espèces entre chaque séparateur comme 
un « groupe ». Les « groupes » ainsi définis, sont utilisés par JUICE pour 

réaliser certaines opérations de tri.

II.B Déplacer les espèces et les relevés à la souris  

Pour déplacer les espèces et les relevés les uns par rapport aux autres à 
l'aide de la souris. Cliquez sur l'espèce ou le relevé choisi, maintenez le bouton 
gauche  de la  souris  enfoncé,  glissez  l'espèce  ou  le  relevé jusqu'à  la  place 
choisie, puis relâchez la souris.
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II.C «     À quoi ça sert …     ?     » Liste des menus et de leur   
contenu :

Les fonctions les plus importantes sont mises en valeur en bleu.

II.C.1 Menu «     File     » :  

– Open :  permet  d'ouvrir  un  fichier  de  travail  de  JUICE  (donc  une  table 
phytosociologique)

– Append : Permet d'adjoindre un autre tableau. [NB : Lors du test ce menu a  
fait planter JUICE.]

– Save : sauvegarde un fichier de travail de JUICE (format .wct) se comporte 
systématiquement comme une fonction « enregistrer sous » : il ne va donc 
pas écraser votre dernier fichier sans vous demander la permission d'abord.

– Import : Les procédures d'importation sont décrites au c  hap  itre     I.B.  

– Export : permet (une fois le travail accompli) de récupérer les tableaux des 
groupements végétaux et de les utiliser dans d'autre logiciels (bloc-note, 
tableur).  Quelques procédures d'exportation sont présentées plus en détail 
dans le chapitre   III.A.  ).

– Conversion : Permet de transformer le format de fichiers. À utiliser dans 
des situations particulières pour des transferts de fichiers.

– Options :  Permet  de  paramétrer  les  différentes  actions  effectuées  par 
JUICE. Voir le chapitre III.B. Dédié à ce sujet.

– End : ferme JUICE

– liste les derniers fichiers utilisés par JUICE
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II.C.2 Menu «     Edit     » :  

– Undo : permet d'annuler la dernière action

– Find Species : Ctrl+F : même fonction que le bouton loupe. Cf. Chap.   II.A.1.   
du présent tutoriel.

– Find Relevé : idem

– Display  parameters :  ouvre  la  fenêtre  d'options  de  JUICE  sur  l'onglet 
« Display parameters » : paramètres d'affichage : taille du texte (boutons ), 
échelle  d'abondance/dominance  utilisée  (menu  déroulant),  largeur  de  la 
colonne de la zone D (données concernant l'espèce).

– Copy [couleur] Species Name, Layer and Species Data to Clipboard : 
copie  les  informations  « nom  d'espèce »,  « strate »  et  « données  de 
l'espèce »  pour  les  espèces  de  la  couleur  actuellement  utilisée  (couleur 
principale) dans le presse-papier.

– Copy [couleur] Relevé Numer, Short Header ans Group Numbers to 
Clipboard :  Semblable  à  la  fonction  précédente  mais  pour  les  relevés. 
Copie les informations : « numéro de relevés », « header data » et « nombre 
de groupes »

– Past Clipboard to [couleur] Species Name : bug détecté

– Past Clipboard to [couleur] Short Headers : bug détecté
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II.C.3 Menu «     Species     » :  

– Undelete Species : annule la suppression d'une espèce.

– Species colour : permet de sauvegarder les attributions de couleurs et de 
charger ces attributions lorsqu'elles ont été sauvegardées.

– Remove Species colour : même fonction que le bouton  dans la zone de 
gestion des couleurs.

– Find Species :  Ctrl+F :  même fonction que le bouton loupe   (Cf.  Chap. 
II.  A.1  .)

– Merge [couleur] Species : Idem que le bouton du même nom (Cf.  Chap. 
II.  A.2.  )

– Merge  all  SAME  Species  Name >  Within  a  LAYER,  ou  >  Within 
DATASET : permet de rassembler en une seule ligne les doublons dans les 
espèces. Soit en agglomérant les doublons présents au sein d'une seule et 
même strate (> Within a LAYER) soit en agglomérant les doublons de toute 
la liste (> Within DATASET).

– Divide Species into (D) a (r)  : sépare les espèces en fonction de leur 
statut : Dominante ou rare. Cf. chapitre II.A.2, paragraphe « merge species / 
divide species »

– Add empty species : permet d'ajouter une ligne pour une espèce dont on 
renseigne le nom et la strate qu'elle occupe, mais pour laquelle on ne peut 
ajouter d'indices d'abondance/dominance.

– Name and Layer Change : permet de modifier le nom et la strate d'une 
espèce. (possible également en double cliquant sur l'espèce souhaitée).

– Highlight (S), (D) and (r) Species : fait apparaître les lettres S, D ou r 
devant les espèces possédant le statut «Agglomérées*», « Dominant » ou 
« rare ». (* : Merge all same species)

– Select Species according to... : permet de chercher une/plusieurs espèce 
en entrant une partie de son nom et de la colorier dans la couleur principale 
de travail active. Affecte toutes les espèces dont le nom comporte la suite 
de lettre entrées pour la recherche.

– Random  Species  Selection :  permet  de  sélectionner  des  espèces  au 
hasard (une ou plusieurs  d'un seul  coup)  et  de leur  affecté une couleur 
définie.

– Species Data : l'une des fonctions les plus importante de ce menu : permet 
d'afficher des informations concernant les espèces dans la zone de données 
(zone D, colonne grisée) :  cela permet d'affiner le travail  de tri  dans les 
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groupes.  Les  possibilités  offertes  par  cette  fonction  seront  détaillées  au 
chapitre III.C.).

– Mark Layer : attribue une couleur (à définir) à chaque strate (efface par là 
même toutes couleurs précédemment attribuées).

– Combine Layer :  permet  de  rassembler  plusieurs  strates  en  une  seule 
(utile par exemple pour alléger les strates en cas d'une différenciation trop 
gênante,  comme  par  exemple  :  agglomérer  les  strates  arborescentes 
hautes, moyennes et basse en une seule strate arborescente).

– Species Statistics : affiche, pour toutes les espèces, plusieurs informations 
statistiques  :  fréquence  (Freq.),  couverture  médiane  (Med.  Cover)  et 
maximale (Max. Cover) et enfin la richesse spécifique moyenne des relevés 
où  l’espèce  est  présente  (Aver.  Rich.). Pour  retourner  à  l'affichage  des 
coefficients d'abondance/dominance, retournez dans le menu « Species » et 
cliquez à nouveau sur « Species Statistics ».

– Autorepeat : fonction non testée.

– Delete [couleur] Species : supprime les espèces de la couleur principale 
active.
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II.C.4 Menu «     Relevés     » :  

– Display Current Relevé : affiche une fenêtre d'information concernant le 
dernier relevé sur lequel on a cliqué. (Le clic peut être effectué au niveau du 
numéro du relevé, comme dans la zone d'affichage (Zone A)).
– nombre d'espèces dans le relevé (supprime les doublons dûs aux strates)
– fourni l'indice de Shannon-Wiener pour le relevé
– fourni la « evenesseveness » c'est à dire l’équitabilité selon la formule de Pielou 

(calculée à partir de l’indice de Shannon-Wiener) ou de celle de Smith-
Wilson. 

– indique  le  degré  de  recouvrement  (comme  un  code  ou  comme  un 
pourcentage)

– affiche la liste des espèces présentes dans le relevé en les triant :
– par strate
– par degré de recouvrement

– par ordre alphabétique
– par séquence* (Seq.)

*  c’est-à-dire l’ordre des espèces dans le tableau

– permet  d'ajouter  une espèce au relevé,  de  supprimer  une espèce du 
relevé et d'éditer les données de tête (Header DataHeader Data)

– Relevé Colours : équivalent de « Species ColoursSpecies Colours », affecte les relevés.

– Remove  Relevé  Colours :  équivalent  de  « Remove  Species  ColoursRemove  Species  Colours », 
affecte les relevés.

– Find Relevé : équivalent de « Find SpeciesFind Species »

Pour  les  trois  fonctions  précédentes,  reportez  vous  aux  fonctions 
équivalentes du menu Species.

– Random Relevé Selection : sélection de relevés au hasard

– Mark relevé :
> from External Filefrom External File : permet de marquer une liste de relevés avec la 
couleur choisie [relevé colourrelevé colour]. Cette liste devant figurer dans un fichier 
texte (*.txt), les numéros des relevés à marquer doivent être inscrits chacun 
sur une ligne, les uns au dessus des autres, sans aucun signe de 
ponctuation.

 >  from Clipboardfrom Clipboard : permet de marquer un relevé unique avec la couleur 
choisie [relevé colourrelevé colour]. Le numéro de ce relevé doit avoir été copié dans le 
presse-papier  (Clipboard),  c'est  à  dire  que  vous  devez  simplement  avoir 
écrit le numéro n'importe où dans l'ordinateur et actionné la fonction Ctrl+C 
ou Edition > CopierEdition > Copier.

– [espèce sélectionnée] Relevés List :  affiche la liste des relevés dans 
lesquels la dernière espèce sélectionnée (par un clic de souris) est présente, 
affiche aussi le degré de recouvrement de l'espèce dans chaque relevés.
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– [couleur] Group Relevés List : affiche la liste des relevés de la couleur de 
travail des relevés active.

– Hunting Dupplicates : permet de vérifier que le jeu de donnée ne contient 
pas de relevés identiques.

– Delete [couleur] Relevés : supprime les relevés de la couleur active.

II.C.5 Menu «     Table     » :  

– List of All Cover and Their Frequency in the Table : affiche une fenêtre 
dans laquelle se trouvent des informations de fréquence pour chaque classe 
de recouvrement.

Table Transformation to Presence/Absence Data : modifie l'information 
d'abondance/dominance (degré de recouvrement)  par une information de 
présence/absence :  attribu  à  tous  les  indices  de  recouvrement  la  valeur 
maximale.  Utilisation  non  recommandée :  mieux  vaut  utiliser  File  >File  >  
Option > Display Parameters > Presence/Absence ScaleOption > Display Parameters > Presence/Absence Scale qui change 
l'affichage sans modifier l'information de recouvrement, et permet donc de 
basculer facilement d'un mode en degré de recouvrement à un mode en 
présence/absence et vice versa.

II.C.6 Menu «     Head     »  

Les « header dataheader data » ou « données de tête » sont les informations 
relatives à chaque relevé (généralement : informations écologiques, 
typologiques et géographiques), stockées dans un fichier à part (format *.dat) 
et affichables dans JUICE afin de permettre leur exploitation lors de l'analyse 
des données de végétation.

Ci-après suit la liste commentée des fonctions de ce menu. Pour plus de 
détail sur leur utilisation, se reporter au chapitre III.D..

Extended Head (Ctrl+H) : Remplace l'affichage de la table par l'affichage de 
l'ensemble des « données de tête », il s'agit de la même fonction que celle 
activée et désactivée grâce au bouton  suivant : 

Initial entry number (Shift+1) : Affiche le numéro du relevé dans JUICE (Cf. 
importation)

Original number (Shift+2) : Affiche le numéro original du relevé (au cas où 
celui-ci serait extrait d'une plus grande table par exemple)

Group number (Shift+3) : si le tableau est divisé grâce à des séparateurs, 
affiche le numéro (ordinal) des groupes ainsi créés.
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Ordinal number (in current tablein current table) (Shift+4) : attribue un numéro croissant à 
chaque relevé en suivant l'ordre de leur affichage actuel.

Store value to short header : Permet d'afficher une courte information 
(valeur  statistique quelconque, valeur d'un indice, ou autre information) à la 
place du numéro de relevé. En cela cette fonction est similaire à l'utilisation 
des « species dataspecies data » (Cf. Chap. III.C. Species Data.). Pour plus de détail sur 
l'utilisation de « Store value to Short HeaderStore value to Short Header », se reporter au chapitre 
III.D.6..

Short Header Selection : permet d'automatiser une sélection dans les 
données de tête. Particulièrement pratique lorsque combiné à la fonction 
précédente. Cf. Chap. III.D.7.

Short Header Average : lorsque des groupes sont distingués à l'aide de 
séparateurs, cette fonction donne la moyenne pour chaque groupe d'une 
valeur stockée dans les « short headershort header », cf. Chap. III.D.8..

Add Short Header to Header Data : basiquement, les « short headershort header » ne 
sont pas enregistrés de manière stable. Si on change leur affichage, on peut 
perdre des informations fraîchement calculées. Si l'on souhaite conserver 
une information stockée dans les « short headershort header » de manière durable, il 
faut l'enregistrer dans les « Header DataHeader Data » proprement dits. Cf. Chap. III.D.9..

Header Data Histogram : permet de connaître de nombre de relevés pour 
chacune des valeurs du paramètre qui est choisi dans la fenêtre qui s’ouvre 
quand on clique sur cette fonction. 

Relevé Colour according to the Head : colorie des relevés en fonction de la 
valeur d'une des variable stockée dans les « Header DataHeader Data ». Cf. Chap. 
III.D.11..

Resampling : permet de ré-échantillonner les relevés. Notamment intéressant 
dans le cadre de comparaisons entre des groupes de relevés composés d’un 
nombre différent de relevés, de surcroît si des tests statistiques sont 
effectués .

Delete Extended Head : supprime les informations stockées comme 
« Header DataHeader Data » .
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II.C.7 Menu   «     Sorting     » :  

– Move Species : « Upwards/Downwards [couleur] Species » même 
fonction que les boutons flèche haut et flèche bas dans l'onglet de 
manipulation des couleurs : déplace toutes les espèces de la couleur de 
travail pour les rassembler au-dessus ou en dessous de l'espèce de cette 
couleur placée le plus bas ou le plus haut dans la liste.

– Move Relevés : idem que pour les espèces, permet également de déplacer 
des relevés à l'intérieur d'un groupe plutôt que sur tout le jeu de données : 
a donc un champ d'action plus important que les boutons.

– Sort Species : idem que le bouton du même nom (Le paragraphe II.A.2. 
pointe ici.)
En cliquant sur cette fonction une nouvelle fenêtre (« Species SortingSpecies Sorting ») 
apparaît. 

Elle montre qu’il est possible de trier toutes les espèces (« AllAll  » dans la 
colonne « Sort speciesSort species »)  ou seulement des espèces coloriées (il faut alors 
cocher la couleur correspondante) au sein de l’ensemble des relevés (« AllAll  » 
dans la colonne « by relevéby relevé ») ou au sein d’un ensemble de relevés coloriés 
(cocher la couleur correspondante).

Les espèces sont triées d’abord en fonction de leur fréquence dans le 
tableau ou partie de tableau, puis selon leur positionnement dans les relevés et 
enfin en tenant compte de leur recouvrement. 

– Sort Relevés : idem que le bouton du même nom. Le principe est le même 
que celui présenté pour le tri des espèces. 

Pour les 4 fonctions précédentes,  il est plus rapide et pratique d'utiliser 
les boutons présentés au chapitre   II.  A.1  .  .

– Sort  Short  Headers :  Les  « Short  HeadersShort  Headers »  correspondent  aux 
informations qui se trouvent dans la zone T de la fenêtre principale de JUICE 
(voir la partie « Prise en main »). Le plus souvent il s’agit des numéros de 
relevés  mais  on  peut  aussi  transférer  d’autres  informations  telles  que 
surface des relevés, recouvrement total de la végétation, indices d’Ellenberg 
ou toute autre information.

Pour procéder à cette opération il faut aller dans le menu HeadHead et cliquer 
sur  Store Values to Short HeadersStore Values to Short Headers (Voir le  chapitre II.C.6.    «     Head     »   à ce 
sujet).  En cliquant sur cette fonction (Sorting > Sort Short HeadersSorting > Sort Short Headers),  la 
fenêtre suivante apparaît à l’écran. 
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Elle montre qu’il est possible de trier l’ensemble des « short headersshort headers » 
(c’est-à-dire  l’ensemble  des  relevés)  ou  de  ceux  qui  ont  été  initialement 
coloriés (c’est alors le nom de la couleur correspondante qui est affichée au 
lieu  de  WhiteWhite),  ceci  alphabétiquement  (s’il  s’agit  d’informations  de  cette 
nature) ou numériquement (s’il s’agit de valeurs), dans un ordre croissant (« inin   
ascending orderascending order ») ou décroissant (« in  descending orderin descending order »).  Le cas échéant 
l’opération peut être effectuée au sein de groupes de relevés séparés par des 
séparateurs (cocher « Within groupsWithin groups »).

– Sort Relevés by Header Data :

REMARQUE: les “Short HeaderShort Header” sont juste une petite partie des “HeaderHeader   
DataData”. Les “Short HeaderShort Header” peuvent être affichés à la place des numéros des 
relevés,  alors  que  les  “Header  DataHeader  Data”  sont  l'ensemble  des  informations  “de 
tête” qui caractérisent chaque relevés. Les “Header DataHeader Data” ne peuvent pas être 
affiché dans leur ensemble en lieu et place du numéro. Pour les visualiser on 
affiche une fenêtre spéciale. (Se reporter au chapitre III.D.1.  “Header Data”  )

Cliquer sur cette fonction fait la fenêtre suivante :
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On  retrouve  les  différents  paramètres  qui  ont  été  intégrés  dans  les 
« Header DataHeader Data ». Il est par conséquent possible d’effectuer un tri de l’un de ces 
paramètres après l’avoir sélectionné. 

Si l’on clique directement sur Continue >>>Continue >>> sans indiquer davantage de 
précisions par rapport à ce qui est proposé dans la fenêtre, la fonction va trier 
les relevés en conservant les numéros de relevés, si bien qu’il est difficile de 
déterminer sur quel critère le tri a été opéré. Pour obtenir cette information, il  
est  recommandé  de  cocher  « Add  first  characters  to  the  short  headAdd  first  characters  to  the  short  head »  (Cf. 
« Remarque » ci-dessus).

L’option  « SeparatorsSeparators »  permet de séparer  les  relevés  ayant  la  même 
valeur ou correspondant à la même chose. Par ailleurs, l’information désirée 
peut être plus ou moins précise en indiquant le nombre de caractères a retenir 
dans « LengthLength ?????? characters fromcharacters from  1  1  positionposition ». Il en est de même pour le 
nombre de décimales quand il s’agit d’une valeur numérique.

– Sort  Species  Alphabeticaly :  permet  de  trier  les  espèces  par  ordre 
alphabétique, soit les espèces sélectionnées avec la couleur active,  et le 
nom de la couleur apparaît alors dans le choix, soit toutes les espèces (AllAll), 
ou toutes les espèces à l'intérieur d'une strate définie (AllAll  withinwithin  layerlayer).

– Sort Species by Species Data (Layer, EIV, etc.)  : permet de trier les 
espèces en fonction des informations contenues dans la zonnes de données 
(zone D, en grisé) vu que ces informations sont très aisément manipulables 
et qu'on peut y insérer a peu près toutes les informations que l'on souhaite : 
il peut s’agir de la fréquence des espèces, des indices d’Ellenberg (EIV) ou 
de  toute  autre  information  (Cf.  chapitre  III.C.). cela  fait  de  cette 
fonctionnalité un outil puissant.
Après  avoir  cliqué  sur  cette  fonction,  on  constate  qu’il  est  possible 
d’effectuer le tri  pour l’ensemble des espèces, ou pour ceux qui  ont été 
initialement coloriés (c’est alors le nom de la couleur correspondante qui est 
affichée au lieu de Black), ceci alphabétiquement (s’il s’agit d’informations 
de cette nature) ou numériquement (s’il s’agit de valeurs), dans un ordre 
croissant ou décroissant (la procédure est similaire à celle vue plus haut 
pour les Short HeadersShort Headers).

– Sort Species in Synoptic Table : réalisable lorsque l'on travaille avec les 
tables synoptiques Cf. chapitre   II  I.E.  .

– Sort Species by Decreasing Association with Other Species :  Cette 
fonction n’est pas développée car elle est relativement complexe et n’a pas 
été  jugé  comme  indispensable  pour  une  analyse  phytosociologique 
standard.

– Sort  Relevés  by  Classification  by  Other  Programs :  nécessite 
l'installation  de  programmes  complémentaires,  avec  lesquels  JUICE  peut 
travailler en interaction. Ceci ne fait pas l'objet de ce tutoriel.
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II.C.8 Menu «     Separators     » :  

Apporte peu de fonctionnalités supplémentaires par rapport aux boutons 
de la barre d'outils. Cf. Chap. II.  A.  .

II.C.9 Menu «     Synoptic Table     » :  

Le  menu  sur  les  tables  synaptiques  est  décrit  de  manière  plus 
approfondie au chapitre   III.E.  , ici les fonctionnalités sont seulement listées.

– Percentage Frequency : affiche la fréquence relative de chaque espèce, 
exprimée en pourcentage.

– Categorical  Frequency :  affiche  la  fréquence  de  chaque  espèce  par 
catégories : V, IV, III, II, I

– Absolute  Frequency :  affiche  la  fréquence  absolue  de  chaque  espèce 
(nombre d'occurences).

– Fidelity : « Les mesures de fidélité statistique sont utiles pour mesurer la  
concentration  d'espèces  dans  une  unité  de  végétation  et  comparer  des  
valeurs  diagnostiques  entre  espèces  dans  une  unité  de  végétation  
particulière ou entre unités de végétation pour une espèce particulière. » 
Issu  de  « JUICE  program  for  management,  analysis  and  classification  of 
ecological  data »,  Tichy & Holt  2006,  section 1.10.,  page 45 ;  traduit  de 
l'anglais.
Voir également le chapitre III.F.1. 
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– Cover  Values  :   permet  d’afficher  différentes  valeurs  relatives  aux 
recouvrements des espèces

– Sort Species in Synoptic Table : 
Cette fonction s’applique uniquement aux tableaux synoptiques et est 

également disponible dans le menu Synoptic TableSynoptic Table.
En cliquant sur cette fonction une nouvelle fenêtre apparaît :

On peut constater que le tri peut concerner l’ensemble des espèces ou 
seulement des espèces initialement coloriées,  que ce tri  peut  être  effectué 
selon  différents  critères  (« Relative  frequencyRelative  frequency », « Absolute  frequencyAbsolute  frequency »…), 
qu’il  peut être réalisé pour l’ensemble des colonnes (éventuellement sauf la 
dernière) ou par colonne séparément. L’information « Cut levelCut level » correspond 
aux seuils des valeurs des différents critères (par exemple 40 pour la fréquence 
relative), seuil préalablement choisi (voir chapitre     : III.F.2.  ).

Il s'agit de la même fonction que celle de nom identique dans le menu 
SortingSorting.

– Analysis of Columns of Synoptic Table : Apporte plus d'information sur 
les groupes (clusters) en fournissant des indices statistiques. Cf.  Chapitre 
III.E.3. pour plus de détails.

– Average Value of Frequency Columns in Synoptic Table : affiche les 
valeurs
moyennes (fréquence, fidélité, couverture) pour chaque groupe. Cf. chapitre 
III.E.4..

– No.  of  Species  in  Columns  of  Synoptic  Table :  affiche  le  nombre 
d'espèces pour 
chaque groupe. Cf. chapitre III.E.5..

– Uniqueness : fonction non testée . Voir aussi chapitre III.E.
– Crispness of classification : fonction non testée . Voir aussi chapitre III.E.
– Compare two synoptic tables : fonction non testée . Voir aussi chapitre III.E.
– Merge two nearest columns : fonction non testée . Voir aussi chapitre III.E.
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– Threshold Values : (valeurs seuils), ouvre la fenêtre d'options de JUICE à 
l'onglet  « Synoptic  TableSynoptic  Table »,  permet d'y  paramétrer  un certain nombre de 
caractères de l'affichage. Cf. chapitre     : III.F.2.  

II.C.10 Menu «     Indicator Values     » :  

– Initiation :  permet  de  charger  les  valeurs  indicatrices  d'Ellenberg  sous 
JUICE. Cf. Chap. II  I.D.  .

– Calculation for Relevés : calcule la valeur moyenne des indices au sein 
d'un relevé.

– Correction for Species Values : fonction non testée.

II.C.11 Menu «     Analysis     » :  

Ce chapitre présente uniquement la LISTE des analyses potentiellement 
disponibles sous JUICE. Ces analyses dépendent pour la plupart de logiciels 

Page 40 / 97



externes et propriétaires, dont la distribution n'est pas libre. Quelques analyses 
disponibles au travers de logiciels libres (R-Project, Mulva ...) sont développées 
plus en profondeur au chapitre III.F..

NB: La plupart des fonctionnalité du menu « Analysis » font appel aux 
fonctionnalités de logiciels autres que JUICE pour réaliser des analyses 

statistiques.
Ces logiciels sont : R, TWINSPAN, MULVA, SYN-TAX 2000, PC-ORD, et enfin 

CANOCO.

• TWINSPAN (Two-way Indicator Species Analysis)
« Analyse de Contingence des Espèces Indicatrices »
http://www.canodraw.com/wintwins.htm 
• TWINSPAN (Hill 1979)"
• Modified TWINSPAN Classification (Rolecek et al. 2009)

• Hierarchical Cluster Analysis
« Classification Hiérarchique »
• PC-ORD (Optimised for Versions 4 and 5)
• MULVA (Optimised for Version 5.1)
• SYN-TAX 2000
• Isopam Method

• Initialize Isopam
• Get Isopam Results

• Non-Hierarchical Cluster Analysis
« Classification Non Hiérarchique »
• SYN-TAX 2000 

• OPTIMCLASS Analysis
Simultaneous  identification  of  optimal  clustering  method  and  optimal 
number of clusters in vegetation classification studies 
« Recherche du nombre optimal de classes (clusters) »

• Results of OPTIMCLASS Analysis

• Ordinations
• CANOCO 4.5 / CANODRAW 4.0

• DCA Analysis « Detrended Correspondance Analysis »
« Analyse des Correspondances Détendancées »

• CA Analysis « Correspondence Analysis »
« Analyse Factorielle des Correspondances »

• PCA Analysis « Principal Component Analysis »
« Analyse en composantes principales »

• CCA, DCCA, RDA Analysis
-> Connected Component Analysis (CCA)
« Analyse Canonique des Correspondances »
-> Detrended Connected Component Analysis (DCCA)
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« Analyse Canonique des Correspondances Détendancées »
-> Representational Difference Analysis
« Analyse de Redondance »

• R-PROJECT
• DCA Analysis
• PCA Analysis
• NMDS Analysis « Non-metric multidimensional scaling »

« Gradation non métrique multidimensionnelle »

• Average ISAMIC Score of Classification (Roberts 2005)

• Co-Occuring Species
• Of Species <selected> For Relevé

• <selected COLOUR>
• All 

• Interspecific Association
• Of Species <selected> For Relevé

• <selected COLOUR>
• All

• INI Groups 

• COCKTAIL Groups 

• Group Aggregation 

• Expert System 

• Matching to <selected COLOUR> Relevés
◦ Frequency-Positive Fidelity Index (FPFI)
◦ Positive Fidelity Index (PFDI)
◦ Frequency Index (FQI)
◦ Normalised Weirdness (ASSOCIA)
◦ Normalised Incompleteness (ASSOCIA)
◦ Normalised Likelihood
◦ Sort Relevés
◦ Matching Export Text File

▪ Frequency Positive Fidelity Index (FPFI)
▪ Positive Fidelity Index (PFDI)
▪ Frequency Index (FQI)

 
• Beals Smoothing

◦ for One Relevé
▪ Calculated from All Relevés
▪ Calculated Only from <selected COLOUR> Relevés
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◦ for <selected COLOUR> Relevé
▪ Calculated from All Relevés

 
• Distance Measures

◦ Distance between Relevé Groups
◦ Total Inertia/ED/Beta-Div within Relevé Groups
◦ Average Jaccard and Sorensen Distances inside Groups

• Diversity
◦ Components of Diversity
◦ Total Inertia/ED/Beta-Div within Relevé Groups

• Species Response Curves

II.C.12 Menu «     Table Simulation     » :  

Permet d'élaborer une table de données factices. Ne fait pas l'objet de ce 
tutoriel.

II.C.13 Menu «     Help     » :  

– Renvoie à différentes aides en ligne :
– page principale du programme,
– manuel d'utilisation en anglais,
– pages Internet renseignant sur certains concepts utilisés par JUICE

– Permet de vérifier la présence de mises à jour.

– Renvoie aux pages web des principaux logiciels que JUICE exploite lors 
des conduites d'analyses statistiques (JUICE ne réalise pas lui même ces 
analyses,  mais  exploite  les  fonctionnalités  de  logiciels  qui  en  sont 
capable).
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III « Comment ça marche ? », chapitre 
d'approfondissement

III.A Menu : «     File > Export     »  

Ce  tutoriel  ne  présente  pas  toutes  les  formes  d'exportation  mais 
uniquement l'exportation, vers un fichier Microsoft Excel(R) (format *.xls), vers 
un fichier texte simple (format *.txt) et vers un fichier texte enrichi (format *.rtf 
– format similaire au format *.doc).

III.A.1 Export vers le tableur M.Excel  (R)   :  

   Etape  1/2 :  
Dans  JUICE,  mettez  vos  données  en  forme,  de  manière  à  ce  que  le 

tableau que vous allez exporter ait l'aspect voulu.
– Allez dans le menu : File > Export > Table > to Spreadsheet FormatFile > Export > Table > to Spreadsheet Format  

FileFile
– Dans la fenêtre qui s'ouvre vous avez seulement la possibilité :

– de sélectionner les relevés à exportés (tous, ou seulement ceux de la 
couleur de votre choix) ;

– de définir le nombre de caractères maximum à exporter pour les noms 
d'espèces  (en  général,  il  devrait  convenir  de  ne  pas  modifier  ce 
paramètre, si lors de l'ouverture du fichier exporté, vous constatez des 
rognures  dans  les  noms  des  espèces,  refaites  la  manipulation  en 
augmentant  d'autant  que  nécessaire  le  nombre  de  caractères  à 
exporter) ;

– de sélectionner les options suivantes selon vos besoins :
– Export header dataExport header data     :  à  cocher  si  vous  avez  utilisé  les  données 

« HeadHead », ce qui ne devrait pas être le cas si vous vous êtes tenu à ce 
tutoriel.

– Export covers in %Export covers in %     : à cocher si vous souhaitez afficher les indices 
de recouvrement en pourcentage de recouvrement.

– Use national species nameUse national species name     : si vous avez importé les noms français 
des espèces, cocher cette case vous permettra de les exporter.

– Cliquez sur le bouton Continue >>>Continue >>>

Une fenêtre d'enregistrement du fichier d'export s'affiche, vous proposant 
de choisir le dossier de destination. Naviguez jusqu'à votre dossier de travail et 
spécifiez le nom de fichier que vous souhaitez utilisé (par défaut il s'agit de 
Excl_exp.txt).
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   Etape 2/2 :
– Ouvrir  Microsoft  Excel(R)   (NB  :  a  priori  l'étape  2  ne  fonctionne  pas 

directement avec le tableur de la suite bureautique d'Open Office).
– Allez dans le menu : Fichier > OuvrirFichier > Ouvrir
– Naviguez jusqu'au dossier où vous avez enregistré le fichier Excl_exp.txt (ou 

tout autre nom que vous lui avez donné).
– Dans  type de fichiertype de fichier, utilisez le menu déroulant pour sélectionner  toustous  

les fichiers (*.*)les fichiers (*.*) ; puis recherchez votre fichier Excl_exp.txt et ouvrez-
le.

La fenêtre de l'assistant d'importation de texte d'Excel(R) va s'ouvrir.
– Dans le cadre Type de données d'origineType de données d'origine, choisissez DélimitéDélimité. En dessous 

de ce cadre, vous avez la possibilité de choisir Commencer l'importation à laCommencer l'importation à la   
ligneligne      avec un numéro de ligne et des flèche pour choisir cette ligne. Il est 
conseillé de commencer l'importation à partir de la première ligne d'espèce 
(qui  devrait  être  la  5e  ligne,  vérifiez-le  dans  l’aperçu  de  votre  fichier). 
Choisissez donc Commencer l'importation à la ligne : 5Commencer l'importation à la ligne : 5 puis cliquez 
sur SuivantSuivant          >>    .

– Dans le cadre SéparateursSéparateurs, décochez TabulationTabulation et cochez Point-virgulePoint-virgule  
puis cliquez sur SuivantSuivant          >>    .

– Dans l'étape 3/3 de l'assistant, il n'y a, a priori, rien à modifier. Cliquez sur 
TerminerTerminer.

Votre tableau se trouve à présent dans Microsoft Excel(R) vous pouvez le 
mettre en forme comme bon vous semble.

III.A.2 Export vers un fichier texte (format *.txt) :  

Dans  JUICE,  mettez  vos  données  en  forme,  de  manière  à  ce  que  le 
tableau que vous allez exporter ait l'aspect voulu.
– Allez dans le menu : File > Export > Table > To Simple Text FileFile > Export > Table > To Simple Text File
– Dans la fenêtre qui s'ouvre vous avez seulement la possibilité :

– de sélectionner les relevés à exportés (tous, ou seulement ceux de la 
couleur de votre choix) ;

– de sélectionner l'option suivante selon vos besoins :
– ««  Use  national  species  nameUse  national  species  name  »» :  si  vous  avez  importé  les  noms 

français  des  espèces,  cocher  cette  case  vous  permettra  de  les 
exporter.

– Cliquez sur le bouton Continue >>>Continue >>>

Une fenêtre d'enregistrement du fichier d'export s'affiche, vous proposant 
de choisir le dossier de destination. Naviguez jusqu'à votre dossier de travail et 
spécifiez le nom de fichier que vous souhaitez utilisé (par défaut il s'agit de 
table.txt)  ;  afin  de  ne  pas  risquer  d'écraser  un  fichier  de  travail  au  nom 
similaire, il est vivement conseillé de changer le nom du fichier à exporter !

L'exportation est terminée. Vous pouvez ouvrir votre fichier table.txt avec 
un logiciel type Bloc-Note / WordPad.

Page 45 / 97



III.A.3 Export vers un fichier texte enrichi (format *.rtf) :  

JUICE privilégie l'export au format de texte enrichi (« Rich Format TextRich Format Text » : 
RTF) dont les fichiers (*.rtf) s'ouvrent avec des logiciel de traitement de texte 
(type  Microsoft  Word(R) ou  Oppen  Office  Writter).  Pour  cela,  JUICE  créer 
automatiquement un fichier au format *.rtf. Celui-ci est vide au démarrage puis 
se rempli au fur et à mesure de vos exportations vers ce fichier. Lors de l'export 
au format *.rtf vous n'avez pas la possibilité de choisir le nom du fichier dans 
lequel vous exportez. Il est donc conseillé de renommer le fichier en utilisant la 
fonction « enregistrer sous » de votre logiciel de traitement de texte lorsque 
vous  aurez  fini  de  travailler  avec  celui-ci.  De  même,  évitez  de  procéder  à 
plusieurs  exportations  d'affilé  vers  le  fichier  RTF,  car  les  tableaux  seraient 
accumulés les uns à la suite des autres dans ce fichier.

Ce fichier prédéfini est nommé export.rtf et se trouve par défaut, soit 
sur  le  bureau,  soit  dans  le  dossier  où  est  installé  JUICE  –  généralement 
C:\Program Files\JUICE.

Vous pouvez modifier cela en allant dans le menu :  File > OptionsFile > Options, 
onglet ExportExport cliquez sur le bouton Change fileChange file et en spécifiant un nouveau 
dossier ou fichier.

Dans  JUICE,  mettez  vos  données  en  forme,  de  manière  à  ce  que  le 
tableau que vous allez exporter ait l'aspect voulu. Allez dans : File > ExportFile > Export  
> Table > To RTF File> Table > To RTF File

Dans la fenêtre qui s'ouvre vous avez la possibilité : 
– dans  le  cadre  « Species  below  the  tableSpecies  below  the  table »  :  de  choisir  de  déplacer  les 

espèces rares en dessous de la table, pour ce faire choisissez In less thanIn less than  
2/3/4 relevés2/3/4 relevés, ce qui affectera le cas échéant, les espèces présentes dans 
moins de 2, 3 ou 4 relevés. Si vous ne souhaitez pas déplacer les espèces 
rares en dessous de la table, choisissez NoneNone.

– dans le cadre « Species exportedSpecies exported » : choisissez allall pour exporter toutes les 
espèces  (recommandé)  ou  bien  with  non-zero  valuewith  non-zero  value pour  exporter 
uniquement les espèces n'ayant pas de valeur(s) nulle(s).

– dans le cadre « Export RelevésExport Relevés » : de choisir d'exporter tous les relevés ou 
seulement ceux de la couleur de votre choix.

– de sélectionner les options suivantes selon vos besoins :
– Export SeparatorsExport Separators     :  pour exporter les lignes de séparation entre les 

relevés.
– Use national species nameUse national species name     : si vous avez importé les noms français 

des espèces, cocher cette case vous permettra de les exporter.

– Cliquez sur le bouton Continue >>>Continue >>>
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L'exportation est terminée. Vous trouverez votre tableau dans le fichier 
« export.rtf », placé par défaut sur le bureau ou dans le dossier où est installé 
JUICE.

N'oubliez  pas  d'aller  ouvrir  ce  fichier,  puis  de  choisir  la  fonction 
Enregistrer sousEnregistrer sous afin de sauvegarder votre travail.

Après cela, supprimer toutes les données du fichier « export.rtf » afin 
que la prochaine exportation se fasse dans un fichier vierge et non à la suite du 
tableau que vous venez d'exporter.

III.B Menu : «     File > Options     »  

La fenêtre d'options comporte 8 onglets :
General
Export
External Program Paths
Check List Import

Fidelity Measures
Synoptic Tables
Display Parameters
Separators
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III.B.1 Onglet «     General     » :  

– « Dimensions  of  the  program »  permet  de  paramétrer  le  nombre  de 
relevés et d'espèces à afficher dans JUICE. Ce paramètre est d'un usage très 
restreint dans le cadre de ce tutoriel, car les débutants ne seront sûrement 
pas concernés par des tableaux aux dimensions importantes. Les chiffres 
dans  les  cases  « relevésrelevés »  et  « speciesspecies »  indiquent  respectivement  le 
maximum  de  relevés  et  d'espèces  à  afficher.  Ces  valeurs  peuvent  être 
élevées jusqu'à respectivement 999 999 relevés et 99 999 espèces, ce qui 
implique  cependant  une  utilisation  plus  importante  de  la  mémoire  de 
l'ordinateur.

– « Find species/relevés function » : la première option (à gauche) indique 
que les caractères utilisés pour la recherche d'une espèce ou d'un relevé 
doivent  obligatoirement  se  trouver  au  début  du  nom de  l'espèce  ou  du 
relevé. La deuxième option (à droite) indique que les caractères utilisés pour 
la recherche peuvent se trouver n'importe où dans le nom de l'espèce ou du 
relevé (début, milieux ou fin).

III.B.2 Onglet «     Export     » :  

Permet de paramétrer l'emplacement du fichier au format de texte enrichi pour 
l'export des tables. Cf. chapitre III.A.3. du présent tutoriel.

III.B.3 Onglet «     External Program Paths     » :  

Comme expliqué précédemment, JUICE ne réalise pas lui même les analyses 
statistiques  que  vous  avez  la  possibilité  de  lancer  dans  le  programme.  Au 
contraire,  il  contient  une  série  de  scripts  qui  lui  permettent  d'utiliser  les 
fonctionnalités de logiciels « amis » comme : Twinspan, D-Map, PC-Ord, Mulva, 
Syn-Tax 2000, R-Project et Canoco. Une synthèse des fonctions offertes par ces 
logiciels est proposée dans BECK (2008).

III.B.4 Onglet «     Check List Import     » :  

permet de définir le chemin d'accès au fichiers des abréviations des noms 
d'espèces lors de l'import de fichiers au format Cornell Condensed. Cf : Chap. 
I.  B.2.  .

III.B.5 Onglet «     Fidelity Measures     » :  

Permet de paramétrer l'affichage de la mesure de fidélité. Cf. Chap. 
II  I.E.1.   > Menu Synoptic TablesSynoptic Tables.
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III.B.6 Onglet «     Synoptic Tables     » :  

Permet de paramétrer l'affichage des tables synoptiques. À ce sujet, voir 
le développement au chapitre III.E.2..

III.B.7 Onglet «     Display Parameters     » :  

Permet de régler la taille du texte et de choisir l'échelle pour les indices 
de 
recouvrement Cf. chapitre II.A.1. (boutons : decrease & increase characters) 

III.B.8 Onglet «     Separators     » :  

Cf. chapitre II.A.4. Zone de paramétrage des séparateurs. 
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III.C Menu : «     Species > Species Data     »  

Le menu : Species > Species DataSpecies > Species Data permet de manipuler la colonne de 
la zone de données (Zone D) Cf. chapitre II. Celle ci permet d'afficher un grand 
nombre d'informations concernant les espèces présentes dans votre tableau. 
Comme cette colonne peut faire l'objet de tri, cela confère à la compréhension 
de  cette  zone  et  à  la  manipulation  de  ces  données  une  importance  toute 
particulière pour le phytosociologue averti.
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III.C.1 «     Layer View     » :  

Permet  d'afficher  la  strate  sous  forme  de  code  numérique,  Cf.  Chap. 
II.A.1. , sous forme de texte (en anglais) ou de combiner les deux.

La strate est affichée par défaut sous forme de code numérique dans la 
zone ''Données''.

Une fois  l'affichage sous forme de texte sélectionné,  vous aurez  sans 
doute besoin de modifier la largeur de la colonne, soit en faisant glisser les 
repères (encerclés en rouge) à l'aide de la souris, soit en passant par « File > 
Options > Display Parameters > Length of additional species information »

III.C.2 «     Indicator Value     » :  

Permet d'afficher dans la zone de Données une des 6 valeurs indicatrices 
d'Ellenberg : Lumière (LightLight), Température, Continentalité, Humidité (MoistureMoisture), 
pH (ReactionReaction), Nutriments (NutrientsNutrients). 

Cf. http://www.tela-botanica.org/projets/18/telechargement/16387
(base de donnée comprenant les valeurs d'Ellenberg pour un grand nombre 
d'espèces).

Nécessite  l'initialisation  de  ces  valeurs. Cf.  section  suivante  : 
Chap.II  I.D.  .
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III.C.3 «     External Species Data     » :  

Permet d'importer des données depuis un fichier texte.
Cette partie du tutoriel nécessite l'utilisation de logiciels type Bloc-notes 

(Notepad - Notepad2) et des fichiers au format texte (*.txt).

Le fichier au format texte (*.txt) depuis lequel vous allez importer vos 
valeurs, doit répondre à une structure très précise.

Le nom des espèces pour lesquelles vous voulez importer des valeurs 
doit être rédigé de manière exactement identique à celle utilisée dans votre 
table.

NB : il n'est pas nécessaire que toutes les espèces de votre table de travail de 
JUICE soit présentes dans ce fichier d'importation. Pour éviter toute erreur 

possible, procédez de la manière suivante :
Dans le menu : Species > Species DataSpecies > Species Data sélectionnez Export SpeciesExport Species  

DataData. JUICE va ouvrir une fenêtre vous demandant de sauvegarder le fichier 
« nom-de-votre-table_SPDAT.txt ».

Cliquez sur SauvegarderSauvegarder puis ouvrez ce fichier. Sa structure correspond 
exactement à celle qui nous est nécessaire à l'importation : deux « colonnes 

fictives » :
1) la première comprenant vos noms d'espèces

2) l'autre comprenant les dernières données avec lesquelles vous avez 
travaillé

(par défaut les indications de strate, prenant la valeur « 0 » et/ou « none »
si celle-ci n'est pas renseignée).

Dans Notepad2, allez dans le menu AffichageAffichage et sélectionnez AfficherAfficher  
les caractères invisibles (Ctrl+MAJ+8)les caractères invisibles (Ctrl+MAJ+8). (NB : les espaces apparaissent 

alors sous la forme de points rouges.)
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Sur la figure ci-dessus on distingue bien nos deux « colonnes fictives » : 
les caractères du début de la ligne jusqu'au dernier point rouge (espace) avant 
le  chiffre  forme  la  « première  colonne »,  les  caractères  suivant  forment  la 
« seconde  colonne ».  (Sur  cet  exemple,  la  « deuxième  colonne »  est 
sélectionnée et s'affiche surlignée en gris. La « première colonne » correspond 
à l'ensemble des caractères insérés avant le début du champ surligné en gris.

Remplacez les valeurs de la « deuxième colonne » par les données que 
vous souhaitez importer. Vous êtes totalement libre de la quantité de texte à 
utiliser (pensez tout de même à rester concis afin de faciliter la manipulation et 
la lisibilité une fois les données importées dans JUICE). Vous pouvez utiliser des 
mots,  des  suites  de  mots  ou  des  suites  de  caractères  numériques  ou 
alphanumériques de votre choix pour coder votre information.

Chaque espèce ne pourra  adopter  lors  de l'importation  qu'une seule 
valeur, même si vous avez deux lignes pour la même espèce (i.e. : parce que 
vous aviez une espèce présente dans deux strates dans votre tableau).

La valeur adoptée sera celle indiquée sur la ligne la plus haut placée pour 
une espèce en doublon. La valeur indiquée sur un doublon situé plus bas dans 
la liste ne sera pas importée,  mais remplacée par la  valeur de la première 
occurrence de l'espèce. Vous pouvez soit supprimer la ligne de l'espèce soit 
laisser le champ vide (NB :  ceci  n'occasionnerait  pas une redistribution des 
valeurs lors de l'import, cet import se faisant en respect de la correction du 
nom et non de la place de la ligne).

Par  exemple,  dans  la  figure  de  la  page  précédente,  l'espèce  « Acer 
pseudoplatanus » apparaît deux fois : en ligne 2 et en ligne 3. Deux valeurs 
différentes ont  étés inscrites  pour cette espèce :  c'est  une erreur :  lors  de 
l'import,  seule  la  valeur  apparaissant  en  premier  pour  cette  espèce  sera 
importée.  Dans  notre  cas  il  s'agira  de  la  valeur  « valeur  test »,  la  valeur 
« beispiel » sera ignorée. Lors de l'import, la ligne 3 correspondant à l'espèce 
« Acer pseudoplatanus » se verra attribuer la valeur « valeur test ». A la place 
de « beispiel » il  aurait fallu laisser un champ vide ou bien écrire :  « valeur 
test ».

Lors  de  la  procédure  d'import  des  données  sous  JUICE,  il  vous  sera 
demandé ou commence et ou s'arrêtent vos deux colonnes (celle des noms 
d'espèces et celle des valeurs). Pour se faire, adoptez la méthode suivante :
– Surlignez le nom d'une espèce et tous les espaces que vous avez insérez à 

sa suite jusqu'au dernier espace précédent la colonne « valeur » inclus. 
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Sur la figure précédente s'affiche en grisé la sélection que vous devez 
opérer. En bas de la fenêtre du logiciel Notepad2, tout à gauche vous trouvez 
plusieurs informations :
« Lig xx : xx Col xx Sél xx »
« Lig xx » correspond au numéro de la ligne sur laquelle vous vous trouvez, 
ou, à celui de la dernière ligne de votre sélection.
«  : xx » correpond au nombre total de lignes dans votre document.
« Col  xx »  correspond  au  numéro  de  la  colonne  devant  laquelle votre 
curseur est situé.
« Sél xx » correspond au nombre de caractères que vous avez sélectionné.
C'est ce dernier nombre qui nous intéresse : il correspond au dernier caractère 
de votre colonne « espèces ». Lors de la procedure d'import, vous devrez donc 
renseigner  pour  la  colonne  « espèce »  :  premier  caractère  =  1er,  dernier 
caractère = 45e.

Sélectionnez ensuite  la totalité de la ligne la plus longue de votre 
fichier,  la  valeur  qui  apparaît  alors  dans « Sél  xx »  correspond au dernier 
caractère  de votre  colonne « valeurs ».  Dans notre exemple la  colonne des 
valeurs commence donc au 46e caractère et s'arrête au 98e.

On peut alors procéder à l'importation des données dans JUICE.
Pour rappel, on est en train d'apprendre à se servir du menu Species >Species >  

Species  Data  > External  Species  DataSpecies  Data  > External  Species  Data donc  allez  cliquez  dessus.  La 
fenêtre JUICE suivante s'affiche :

C'est  là  que  vous  comprenez  toute  l'utilité  de  la  démarche  effectuée 
jusqu'à présent : dans le cadre « Parameters for species selectionParameters for species selection » entrez le 
premier et le dernier caractère de votre colonne « espèces », dans le cadre 
« Species  informationSpecies  information »  entrez  le  premier  et  le  dernier  caractère  de  votre 
colonne « données » (comme indiqué page précédente).

A présent il reste à choisir :
D'utiliser ces valeurs pour effectuer un marquage de couleur dans votre 

tableau. Pour cela cochez la première option : Mark [couleur] species withMark [couleur] species with  
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the value [valeur] with the colour [couleur]the value [valeur] with the colour [couleur] qui signifie : ''marquer les 
espèces de couleur [couleur] avec la valeur [valeur] en [couleur]'' ce qui aurait 
pour  résultat  dans  notre  exemple  de  marquer  en  bleu  les  espèces  déjà 
marquées en rouge pour lesquelles la valeur serait vide. Et valider en cliquant 
sur le bouton Continue >>>Continue >>>

NB : la fenêtre ne disparaît pas mais si vous cliquez à présent sur le bouton 
CancelCancel vous verez que votre marquage a été effectué.

Ou d'importer vos données pour toutes les espèces (all), ou seulement 
pour les espèces d'une couleur de votre choix. Pour cela cochez la seconde 
option :  Import data for [couleur] speciesImport data for [couleur] species.  Puis  cliquez sur  le  bouton 
Continue >>>Continue >>>

III.C.4 «     Cover Value     » :  

Permet  d'afficher  une  valeur  d'abondance/dominance  (degré  de 
recouvrement)

Page 55 / 97



– Minimum  Cover :  afficher  la  plus  petite  valeur  de  recouvrement  que 
possède l'espèce au sein de tous les relevés

– Average Nonzero Cover : fait la moyenne des valeurs non nulles (donc 
calcul la moyenne de recouvrement de la plante au sein des relevés où elle 
est présente – exclue les relevés ou la plante est absente).

– Median Cover : affiche la valeur de recouvrement médiane
– Maximum Cover : affiche la valeur de recouvrement la plus grande

NB : les degrés de recouvrement affichés dans la zone « Données » sont 
indiqués en pourcentage et non dans le code que vous utilisez (comme par 
exemple  l'échelle  « Braun-Blanquet  Old  Scale  Normal »).  Si  vous  ne 
connaissez pas l'équivalence qui existe, vous pouvez l'obtenir simplement 
en allant  dans :  File > Options > Display Parameters > CurrentFile > Options > Display Parameters > Current  
scalescale et en choisissant dans le menu déroulant :  User Defined ScaleUser Defined Scale  
puis en cliquant sur le bouton ModifyModify.

La fenêtre suivante s'ouvre dans JUICE : 

NB : à la première utilisation cette fenêtre affiche des cases vides – que 
vous pouvez choisir de remplir vous-même si vous travailler avec une échelle 
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de recouvrement personnelle.

Cochez (par défaut) la case Braun-Blanquet old scaleBraun-Blanquet old scale - c'est l'échelle 
la plus répandue - (ou tout autre échelle que vous utilisez) puis cliquez sur le 
bouton  Fill  in  the  predefined  scaleFill  in  the  predefined  scale les  indices  de  l'échelle  choisie 
s'affichent  alors  en  face  des  pourcentages  qui  leurs  correspondent.  Vous 
pouvez utiliser la fonction « Impr écr » (située sur une des touches de votre 
clavier, en général en haut à droite de celui-ci) puis ouvrir le logiciel « Paint(R) » 
de Microsoft Windows(R) ou tout autre logiciel de dessin et utiliser la fonction 
Edition > collerEdition > coller (Ctrl+V)  pour  obtenir  une  image  de  votre  échelle  de 
correspondance que vous pouvez alors sauvegarder et conserver durablement 
afin de l'utiliser à côté de JUICE. Ou bien vous servir tout simplement de celle 
qui figure ci-dessus.

III.C.5 «     Frequency     » :  

Permet  d'afficher  dans  la  zone  des  données  la  fréquence  absolue  de 
l'espèce.

Soit dans toute la table (All Table),  soit dans les relevés de la couleur 
active ([couleur] Relevés), soit la fréquence au sein des relevés pour lesquels la 
valeur de recouvrement est plus grande qu'une  limite (« thresholdthreshold ») définie 
(à définir dans le menu :  File > OptionsFile > Options, onglet  Synoptic TablesSynoptic Tables, valeurs 
« Cover threshold:Cover threshold: » basse (lowerlower) et haute (higherhigher).

Page 57 / 97



III.C.6 «     Sequence     » :  

Attribue un numéro à chaque espèce de votre liste, de 1 à n dans l'ordre 
dans lequel se trouve votre liste au moment où vous utilisez cette fonction. Le 
principal usage de cette fonction est sans doute de pouvoir retrouver 
facilement un agencement spécifique. Une manière de « sauvegarder » 
l'information de la place des espèces les unes par rapport aux autres, avant 
d'apporter des modifications à cet agencement.

III.C.7 «     Species Color Number     » :  

Attribue à chaque espèce le numéro de sa couleur (0 pour noir, 1 pour 
rouge, 2 pour bleu, etc. en suivant l'ordre des couleurs de la barre de tâches).

III.C.8 «     Calculator     » :  

Permet de réaliser des opérations mathématiques simples sur une valeur 
numérique enregistrée dans la colonne « Données ».
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III.C.9 «     Constant Value for [couleur] Species     » :  

Permet d'attribuée une valeur constante aux espèces de la couleur 
active.

III.C.10 «     Make Separators     » :  

Chaque fois que la valeur de la donnée d'une espèce n'est pas identique 
à celle de sa voisine du dessous, JUICE insère un séparateur entre ces deux 
espèces.

III.C.11 «     Species Data Averages     » :  

Lorsque  les  valeurs  dans  la  colonne  des  données  sont  sous  forme 
numérique, ouvre une fenêtre qui donne la moyenne (averageaverage) ou la valeur 
minimale ou maximale.

III.C.12 «     Export Species Data     » :  

Permet  d'exporter  la  liste  des  espèces  avec  leurs  valeurs 
correspondantes dans un fichier texte (*.txt).

III.C.13 «     Species Group Table - ...     » :  

Permet d'afficher des tableaux récapitulatifs sur la répartition de groupes 
de végétaux au sein des relevés. Pour illustrer les quatres fonctions suivantes, 
on considérera les « groupes » suivant :
– groupe  « Acer campestre s. campestre »  comprenant  3  espèces  :  Acer 

campestre en strate arborescente, Acer pseudoplatanus en strate arbustive 
et Acer pseudoplatanus en strate arborescente.

– Groupe « Aconitum napellus s. vulgare » comprenant 3 espèces : Aconitum 
napellus,  Adoxa  moschatellina et  Allium  ursinum toutes  trois  en  strate 
herbacée.

– Groupe  « Anemone  nemerosa »  comprenant  3  espèces  :  Anemone 
nemerosa,  Anemone  ranunculoides et  Arum  maculatum,  toutes  trois  en 
strate herbacée.

Cf. Tableau page suivante.

NB : La  réalité  de  ces  groupes  ne  nous  intéresse  pas,  il  s'agit  de  
montrer le fonctionnement des fonctionnalités. La réalité des résultats 
n'est pas l'objet !
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13.a « Species Group Table - FREQUENCY (%) » :

Affiche  (en  vertical)  pour  chaque  relevé,  la  fréquence  d'apparition 
d'espèces au sein de ce relevé (en pourcentage) :

Dans le groupe un, sur les trois espèces qui composent le groupe, seules 
deux apparaissent dans le relevé 1 : 2/3 = 67%. Une seule espèce apparaît  
dans le relevé 2 : 1/3 = 33%. Les trois espèces sont présentes dans le relevé 
3 : 3/3 = 100%. etc.
NB  :  JUICE  affiche  également  le  nombre  d'espèces  présentes  dans  chaque 
groupe (Total: 3).

13.b « Species Group Table - FREQUENCY (cat. I-V) » :

Affiche le même résultat sous forme de catégories de I à V.

13.c « Species Group Table - COVER » :

Non testé

13.d « Species Group Table – SPECIES No. » :

Affiche le nombre d'espèce du groupe présentes dans chaque relevés.
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III.C.14 «     Clear All Species Data     » :  

Efface les valeurs de la colonne « Données » (zone  D, en grisé dans la 
fenêtre principale). Celle-ci apparaît alors vide.
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III.D Menu «     Head     » (  Tête  )  

Ce  menu  permet  de  manipuler  les  données  numériques  et  les 
informations relatives aux relevés de végétation et qui constituent les « HeaderHeader   
datadata » (Données de tête).  Deux catégories de « Header dataHeader data » peuvent être 
distinguées :

- les « Short Headers dataShort Headers data »
qui sont affichées dans la partie supérieure du tableau de relevés. Ce 

sont  par  exemple  les  numéros  de  relevés  mais  cela  peut  être  aussi  des 
informations telles que des valeurs calculées à partir des indices d’Ellenberg, 
sachant  que  le  nombre  de  caractère  est  de  6  au  maximum,  lesquels  sont 
distribués verticalement ;

- les « Extended Headers dataExtended Headers data »
correspondent  à  l’ensemble  des  données  et  informations  qui  ont  été 

importées dans JUICE mais qui  ne sont pas affichées directement à l’écran. 

Cependant,  en  cliquant  sur  le  bouton  «tête  de  clown »   dans  la  barre 
d'outils, il  est possible de visualiser l’ensemble des informations qui ont été 
réunies.

Outre  la  possibilité  d’afficher  en  « Short  HeadersShort  Headers »  différentes 
informations, ce menu propose plusieurs fonctions permettant de caractériser 
chaque relevé ou groupe de relevés en fonction des données disponibles.
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III.D.1 «     Extended   Head     »   (Tête étendue)  

Cette fonction permet d’afficher à l’écran l’ensemble des informations qui 

ont été réunies ; c’est l’équivalent du bouton « tête de clown » .

La figure suivante montre un exemple de « Extended HeadExtended Head » :

III.D.2 «     Initial Entry Number     »  

Cette option affiche en « Short HeaderShort Header » la numérotation des relevés qui 
a été retenue lors de la première étape d’importation.

III.D.3 «     Original Number (‘Relevé number’)     »  

Dans  ce  cas  les  « Short  HeadersShort  Headers »  peuvent  présenter  des  numéros 
particuliers qui auraient été affectés aux relevés par l’utilisateur.  Si tel n’est 
pas le cas, « Initial Entry NumberInitial Entry Number » et « Original Number (‘Relevé number’)Original Number (‘Relevé number’) » 
correspondent aux mêmes numéros. Quand les données ont été importées à 
partir de TURBOVEG, ce sont les numéros retenus dans cette base de données 
qui s’affichent sous cette option.

III.D.4 «     Group Number     »  

Cette  option  numérote  des  groupes  de relevés  dans  la  mesure  où  le 
tableau est partitionné par des séparateurs. 

Page 63 / 97



III.D.5 «     Ordinal Number     (in Current table) »  

Si  les  relevés  et  donc  leurs  numéros  ont  été  redistribués  par  une 
opération de classification (p.e. :  Twinspan),  en sélectionnant  cette fonction, 
JUICE numérote les relevés du tableau dans un ordre croissant sans modifier la 
position  des  relevés.  Cette  fonction  est  par  exemple  utile  pour  rappeler  le 
nombre de relevés qui composent le tableau. 

III.D.6 «     Store Values to Short Headers »  

En  cliquant  sur  cette  fonction,  plusieurs  paramètres  sont  proposés  à 
l’affichage en « Short HeadersShort Headers ».

- Number of <Colour> Species permet d’afficher en « Short HeadersShort Headers » 
le nombre d’espèces de la couleur sélectionnée pour chaque relevé. Cela 
peut être utile pour comptabiliser une catégorie d’espèces (par exemple 
un types biologique ou un type écologique) au sein des relevés ;

- Percentage  Number  of  <Colour>  Species  donne  les  mêmes 
informations que la proposition précédente mais en terme de fréquences 
relatives ;

- Percentage Cover of <Colour> Species  correspond aussi au même 
type  d’information  mais  en  prenant  en  compte  les  pourcentages  de 
recouvrement des espèces ;

- Header data. En cliquant sur cette option, une nouvelle fenêtre apparaît 
(cf figure suivante) qui liste tous les paramètres retenus dans « ExtendedExtended  
HeadHead ».  
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En sélectionnant l’un de ces paramètres,  le nombre de caractères est 
affiché dans la case « LengthLength », mais compte tenu qu’il apparaîtra en « Short 
Headers » seuls les 6 premiers caractères seront retenus. On peut néanmoins 
préciser dans « LengthLength » le nombre de caractère désiré si celui-ci est inférieur à 
6.  La  deuxième  case  sert  à  spécifier  si  l'on  souhaite  que  l'affichage  ne 
commence pas au premier caractère mais à partir d'un caractère donné.

- « Diversity Indices » offre la possibilité d’afficher en « Short headersShort headers » 
soit l’indice de Shannon-Wiener, soit l’indice de Simpson.

- Evenness  exprime l’équitabilité selon la formule de Pielou (calculée à 
partir de l’indice de Shannon-Wiener) ou de celle de Smith-Wilson. 

- Geographical Grid Position 

Cette fonction nécessite de disposer des coordonnées géographiques des 
relevés. Elle permet d’afficher en « Short HeadersShort Headers » un index indiquant quels 
sont les relevés qui sont localisés dans une même grille géographique virtuelle. 
Autrement dit, les relevés pour lesquels le même index est affecté se trouvent 
dans la  même grille.  Il  s’agit  donc d’une information concernant  la  densité 
d’échantillonnage  des  relevés.  Le  cas  échéant  l’échantillonnage  peut  être 
modifié  via la fonction « Resampling » intégrée dans le menu « Head » (voir 
plus loin). 

En cliquant sur la fonction, la fenêtre suivante apparaît à l’écran :

Elle permet de modifier (si nécessaire) la taille de la grille en agissant sur 
les valeurs de latitude et de longitude, de conduire l’analyse en prenant en 
compte  les  groupes  de  relevés  (cocher  alors  « Within  groups »)  si  une 
classification a été effectuée, de préciser éventuellement la zone géographique 
pour laquelle la recherche est réalisée.

- Distance  from  Selected  Relevé  constitue  une  fonction  très 
intéressante car elle permet de déterminer dans un ordre décroissant les 
relevés les plus proches d’un relevé qui a été au préalable sélectionné 
(en cliquant sur celui-ci). Deux possibilités sont offertes :
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+ Euclidean Distance
La distance euclidienne permet en effet de mesurer la similarité entre 

deux relevés ; plus la distance est faible et plus les relevés sont proches sur le 
plan de la composition floristique et ce, dans ce cas,  en tenant compte du 
recouvrement des espèces (sauf si dans « Data transformation » a été coché 
« Presence/Absence »  ce  qui  n’est  pas  judicieux  puisque  la  distance 
euclidienne peut prendre en compte le « poids des espèces » c’est-à-dire leur 
recouvrement).

+ Bray-Curtis (Sorensen) Distance
La distance de Bray-Curtis est une version sous forme de distance de 

l’indice de similarité de Sorensen.

Après  avoir  cliqué  par  exemple  sur  l’option  « Euclidean Distance » 
s’ouvre la fenêtre suivante :

– Selected relevé est le relevé sur lequel l’utilisateur a cliqué.

– TURBOVEG No.  est  le  numéro  du  relevé  dans  la  base  de  données 
TURBOVEG.

– Short head value  est  le  numéro  du  relevé  qui  figure  en  « ShortShort   
HeadersHeaders » (ici le même que celui de TURBOVEG).

– Data transformation :  les  recouvrements  des  espèces  peuvent  être 
transformés en racines carrés ou en données binaires présence/absence.

– Save ED (Euclidean Distance)  into short headers permet d’afficher 
les resultats en « Short HeadersShort Headers  » (ce qui est logique puisque la fonction 
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générale de travail est « Store Values to Short HeadersStore Values to Short Headers »).

– Calculate ED and find the most similar relevés est  le bouton sur 
lequel il faut cliquer pour que les résultats apparaissent dans la fenêtre.

La  première  colonne  indique  la  valeur  de  la  distance  euclidienne,  la 
deuxième le numéro du relevé correspondant à cette valeur, la troisième le 
numéro de relevé TURBOVEG, la quatrième correspond au numéro de groupe 
de relevés (dans l'exemple, le tableau a été auparavant soumis à une analyse 
Twinspan),  la  cinquième  colonne  rappelle  la  donnée  affichée  en  « ShortShort   
HeadersHeaders », ici en l’occurrence le numéro de relevé.

À noter que des recoupements peuvent être effectués en affichant en 
« Short HeadersShort Headers » une information extraite des « Extended Headers dataExtended Headers data » (cf 
« Store Values to Short HeadersStore Values to Short Headers » suivi par « Header Data »). Par exemple, si 
on considère le facteur hygrophilie du milieu (calculé auparavant à partir des 
indices d’Ellenberg pour chaque relevé) et si on calcule cette fois les distances 
en choisissant la distance Bray-Curtis, la fenêtre fournira les résultats suivants :

On constate que les relevés les plus proches correspondent bien à des 
valeurs élevées d’hygrophilie (dernière colonne ShHeadShHead) et qu’ils appartiennent 
tous au même groupe de relevés (2). Par ailleurs, « Data transformationData transformation » est 
« muet »  car  l’indice  est  calculé  à  partir  de  données  binaires  en 
présence/absence. 
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- Potential Annual Direct Irradiation And Heat Load  Cette fonction 
est relativement complexe et n’est pas présentée dans le cadre de ce 
manuel.

- Random Number permet de re-numéroter les relevés de façon aléatoire 
ce qui peut être pertinent dans le cadre de tests statistiques.

- Random Permutation of Short Headers redistribue de façon aléatoire 
les “Short Headers” mais sans modifier l’organisation des relevés.

- Random  Permutation  of  Relevés  réorganise  de  façon  aléatoire 
l’ensemble du tableau.

- Sum,  Mean,  Median,  Minimum,  Maximum,  Standard  Deviation, 
Average  of  <Colour>  Species  Data  constituent  un  ensemble  de 
fonctions  permettant  d’afficher  en  « Short  HeadersShort  Headers »  des  données 
résultant d’opérations prenant en compte les « Species DataSpecies Data » (comme 
les indices d’Ellenberg) qui sont à introduire dans la colonne du tableau 
réservée  à  cet  effet  (à  droite  de  la  colonne  « LayersLayers »  via  le  menu 
Species > Species Data).

A  titre  d’exemple,  la  figure  suivante  donne  en  « Short  HeadersShort  Headers »  les 
sommes des valeurs d’hygrophilie  calculées à partir  des indices d’Ellenberg 
(colonne des « Species DataSpecies Data » -> zone « D ») pour les espèces sélectionnées 
par la couleur rouge.

À noter que pour les deux dernières fonctions : « Average of <Colour>Average of <Colour>   
Species  Data  Weighted  by  CoverSpecies  Data  Weighted  by  Cover »  et  « Sum  of  <Colour>  Species  DataSum  of  <Colour>  Species  Data   
Weighted by CoverWeighted by Cover », les résultats sont pondérés par les recouvrements des 
espèces.
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III.D.7 « Short Header Selection ».  

Cette fonction permet de sélectionner (par une couleur) les relevés dont 
les  « Short  HeadersShort  Headers »  sont  inférieures,  égales  ou  supérieures  à  une  valeur 
donnée quand on coche Numerically. Si les « Short HeadersShort Headers » sont composées 
de caractères il faut cocher Aphabetically.

III.D.8 « Short Header Averages ».  

On peut par cette fonction connaître la valeur moyenne d’un paramètre 
affiché  en  « Short  HeadersShort  Headers »  pour  chaque  groupe  de  relevés  issu  d’une 
classification.

Il est également possible d’afficher la valeur minimum, maximum et la 
déviation standard pour chaque groupe.
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III.D.9 « Add Short Headers to Header Data ».  

Par cette fonction, il est possible de sauvegarder des données nouvelles 
affichées en « Short HeadersShort Headers » dans l’ensemble des données constituant les 
« Extended Headers dataExtended Headers data ». Par exemple, sachant que la fonction Calculation 
for Relevés du menu Indicator Values permet de connaître et d’afficher les 
valeurs moyennes des indices d’Ellenberg pour chaque relevé, il est possible 
avec  Add  Short  Headers  to  Header  Data de  rentrer  ces  valeurs  dans 
«Header DataHeader Data» après avoir, comme le montre la figure suivante, précisé le nom 
sous lequel elles seront recensées.

III.D.10 « Header Data Histogram »  

Permet de connaître de nombre de relevés pour chacune des valeurs du 
paramètre qui est choisi dans la fenêtre qui s’ouvre quand on clique sur cette 
fonction.

Page 70 / 97



III.D.11 « Relevé Colour According to the Head »  

Cette fonction permet de repérer des relevés à l’aide d’une couleur : dans 
la  fenêtre :  1st  Step  Select  colour en  sélectionnant  le  paramètre  qui 
correspond  à  l’affichage  en  « Short  Headers »  (2  nd   Step  )  et  en  indiquant 
(3  rd     Step  ) la valeur du paramètre ou les caractères d’un paramètre s’il s’agit 
d’une donnée non-numérique (dans ce dernier cas,  utiliser  des apostrophes 
pour encadrer la chaine de caractères).

III.D.12 « Resampling »  

Cette  fonction  de  ré-échantillonnage  peut  être  très  intéressante  et 
pertinente  dans  le  cadre  de  comparaisons  entre  des  groupes  de  relevés 
composés d’un nombre différent de relevés, de surcroît si des tests statistiques 
sont effectués. 

Trois possibilités sont proposées par JUICE.
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12.a Random Resampling

Avec cette fonction, il est par exemple possible de sélectionner le même 
nombre de relevés dans chacun des groupes. La fenêtre qui s’ouvre dans le 
cadre de cette fonction (figure suivante) offre deux manières de procéder :  

+ « manuellement » en cochant en haut de la fenêtre qui est apparue 
Select relevés with manual switches. Il faut ensuite conduire l’opération 
groupe  après  groupe  en  agissant  sur  le  bouton  Separator  group et  en 
précisant avec le bouton No. of selected relevés le nombre de relevés que 
l’on désire sélectionner. Le bouton  <Click> permet de choisir la couleur des 
relevés qui seront sélectionnés.

+ « automatiquement » en cochant la deuxième possibilité. Plusieurs 
solutions sont proposées, dans l’ordre :

1. Sélection aléatoire de relevés sans prendre en compte les groupes, le 
nombre de relevés  étant  déterminé en cochant  en bas  Number of 
sel. Relevés in the whole table et en précisant le nombre ;
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2. Sélection aléatoire d’un nombre égal de relevés au sein de chaque 
groupe, le nombre étant précisé cette fois en cochant en bas
Max number of sel. Relevés in each relevé group ;

3. Sélection d’un nombre identique de relevés au sein de chaque groupe 
en partant du premier relevé des groupes ;

4. Sélection d’un nombre identique de relevés au sein de chaque groupe 
en partant du dernier relevé des groupes ;

Il faut bien sûr terminer en cliquant sur Select pour que l’opération soit 
effectuée.

12.b Geographical Stratification

Comme pour la fonction  Geographical Grid Position du sous-menu 
Store Values to Short Headers, cette fonction nécessite de disposer des 
coordonnées géographiques des relevés.

Il s’agit dans ce cas de procéder à un ré-échantillonnage des relevés sur 
le  plan  géographique.  Cette  fonction  est  très  utile  dans  le  cadre  des 
classifications  en  permettant  de  conduire  des  analyses  à  partir  d’un 
échantillonnage  mieux stratifié  lorsque le  territoire  considéré présente  des 
secteurs  sur-échantillonnés.  Cela  permet  d’éviter  des  pseudoréplications  et 
d’améliorer la représentativité des données.

En cliquant sur cette fonction, la fenêtre suivante apparaît à l’écran :

Page 73 / 97



Dans « ParametersParameters » on peut choisir  la  couleur des relevés qui  seront 
éliminés lors  du ré-échantillonnage et le nombre de relevés que l’on désire 
conserver dans chacune des grilles géographiques.

La taille des celles-ci est définie à partir de « Geographical grid spacingGeographical grid spacing » 
selon les mêmes principes que la fonction  Geographical Grid Position du 
sous-menu  Store Values to Short Headers. En cochant  Save geogr.grid 
code  to  short headers pourront  être  affichés  en  « Short  HeadersShort  Headers »  les 
mêmes index que ceux obtenus à partir de « Geographical Grid PositionGeographical Grid Position ». Le 
cas  échéant,  le  ré-échantillonnage  peut  tenir  compte  d’une  classification 
préalable  en  cochant  Within groups defined by separators.  Le  bouton 
Geographical Grid Spacing Test permet l’affichage des index en « ShortShort   
HeadersHeaders ».

Sont aussi proposés un certain nombre de critères (Mousses identifiées, 
Aire  > 0,  etc.)  pouvant  être  pris  en  compte lors  du  ré-échantillonnage.  En 
l’absence d’informations à ce sujet il convient de décocher chacune des cases. 

Le ré-échantillonnage est effectué en cliquant sur  Continue >>> et les 
relevés  à  éliminer  apparaissent  dans  le  tableau  selon  la  couleur  qui  a  été 
initialement choisie. Il suffit ensuite des les éliminer avec la fonction  Delete 
<Colour> Relevés du menu Relevés.

12.c Constrained Resampling (Ré-échantillonnage sous contrainte)

Cliquer sur cette fonction ouvre la fenêtre suivante 
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Le ré-échantillonnage est effectué dans ce cas en le contraignant non 
plus d’un point de vue géographique mais en prenant en compte les distances 
entre les relevés comme il est indiqué au bas de la fenêtre (EuclideanEuclidean ou Bray-Bray-
CurtisCurtis déjà rencontrées dans la fonction Distance from Selected Relevé du 
sous-menu Store Values to Short Headers).

La fenêtre rappelle un certain nombre d’informations relatives au tableau 
de relevés et  permet de choisir  une couleur  (« Relevé colour  of  resampledRelevé colour  of  resampled   
relevésrelevés ») pour le repérage des relevés qui seront retenus dans le cadre de 
cette  opération  de  ré-échantillonnage.  Comme  toujours  quand  il  s’agit  de 
distances, les données peuvent être transformées (en présence/Absence et il 
faut  alors  indiquer  0.0  pour  p=,  en  racines-carrées  avec  p = 0.5)  ou  non 
transformées (p = 1.0) ou encore être exprimées en log. 

Dans  la  partie  « Resampling  parametersResampling  parameters »  il  convient  d’indiquer  le 
nombre  de  relevés  que  l’on  désire  retenir  dans  chaque  groupe :  No.  of 
relevés to be selected from each stratum ; la taille du groupe (Groupe 
size ...) pour laquelle on ne veut pas de sélection de relevés (donc tous les 
relevés seront colorés par la couleur initialement choisie) ; le nombre d’essais 
(Number  of  trials)  effectués  au  cours  de  cette  opération  de  ré-
échantillonnage. En effet, JUICE va chercher à maximiser les distances entre les 
relevés à sélectionner.

III.D.13 « Delete Extended Head »  

Cette  fonction  permet  d’effacer  les  données  de  « Extended  HeadersExtended  Headers   
datadata » et est donc à utiliser avec prudence car cela efface toutes les données !
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III.E Menu : «     Indicator Values > Initiation     »  

Le menu « Indicator  Values »,  permet d'utiliser  dans  JUICE les  valeurs 
indicatrices des végétaux, telles que décrite par Heinz Ellenberg.

Ces valeurs sont au nombre de six :
– L : lumière (Lichtzahl)
– T : température (Temperaturezahl)
– K : continentalité (Kontinentalitätzahl)
– F : humidité (Feuchtezahl)
– R : acidité (Reaktionzahl)  Il ne s'agit pas d'une valeur de pH !
– N : nutriments (Nährstoffzahl)

NB : La salinité n'est pas paramétrable sous JUICE en tant que valeur 
indicatrice. Cependant, vous pouvez très facilement l'importer en tant que 

valeurs attribuée aux espèces dans la zone de données.
Voir chapitre « External Species Data ».

Pour utiliser les valeurs d'Ellenberg, celles-ci doivent être initialisées. Pour 
cela, aller dans le menu Indicator Values > Initiation une fenêtre JUICE 
va s'ouvrir.  Cliquez sur le bouton  Initiation of indicator values.  JUICE 
demande où se trouve le fichier texte (*.txt) dans lequel sont enregistrées les 
valeurs d'Ellenberg.  Lui  indiquer le chemin vers celui-ci  et laisser le logiciel 
charger les valeurs.

Un  fichier  tout  prêt,  au  format  text  (*.txt),  contenant  les  valeurs 
indicatrices d'Ellenberg est mis à disposition à l'adresse suivante :

Document     :   Ellenberg indicator values (EIV) : ELLENB.txt 
http://www.wuala.com/Floppyboy/phytosocio/ELLENB.TXT
(Source : Georg-August Universität Göttingen, Albrecht-von-Haller-Institut 

für Pflanzenwissenschaften)

Au besoin, vous pouvez également vous reporter à la base de données 
maintenue  par  l'association  TELA-BOTANICA  et  Philippe  JULVE à  l'adresse 
Internet suivante:

Document     :   Baseflor
http://www.tela-botanica.org/page:liste_projets?id_projet=18 
« Baseflor » contient non seulement les valeurs indicatrices d'Ellenberg 

mais  également  les  valeurs  de  « valence écologique »  développées  par  Ph. 
JULVE.

Page 76 / 97

http://www.tela-botanica.org/page:liste_projets?id_projet=18
http://www.wuala.com/Floppyboy/phytosocio/ELLENB.TXT


III.F Menu «     Synoptic Table     »  

Les  tableaux synoptiques  proposent  une présentation  synthétique des 
résultats issus d’une classification des relevés. Ils permettent aussi de vérifier 
la cohérence des divisions d’une classification, de définir différentes catégories 
d’espèces (diagnostiques, constantes et dominantes) et d’exprimer quelques 
informations plus générales.

REMARQUE :  il  est  évidemment  nécessaire  de  disposer  au 
préalable d’un tableau issu d’une classification avec des séparateurs 
(par  exemple  un  tableau  résultant  d’une  analyse  opérée  par  
twinspan).

III.F.1 Le concept de «     fidélité     »  

Différentes présentations sont proposées dans le menu, il suffit de cliquer 
sur la modalité souhaitée. L’une de ces modalités, la fidélité, est importante à 
prendre en compte.

C’est un concept central en phytosociologie, un objectif majeur de cette 
discipline consistant à définir des combinaisons caractéristiques et originales 
d’espèces  végétales  (c’est-à-dire  des  unités  de  végétation  comme  les 
associations  végétales)  composant  la  végétation.  Il  est  par  conséquent 
essentiel d’évaluer l’appartenance plus ou moins forte des espèces à une unité 
de végétation  dans le  cadre de la  caractérisation de ces  unités.  La fidélité 
répond à ce souci et peut être définie comme une mesure de la concentration 
d’une espèce dans une unité de végétation. Dans la mesure où une espèce est 
particulièrement fidèle à une unité elle est qualifiée d’espèce diagnostique 
(ou caractéristique) de cette unité. Les mesures de fidélité permettent aussi de 
comparer  les  valeurs  diagnostiques  entre  espèces  dans  une  unité  de 
végétation  particulière  ou  entre  unités  de  végétation  pour  une  espèce 
particulière.

Voir également le chapitre sur les valeurs seuils pour le paramétrage de 
la  fidélité  ou  les  documents  PDF  suivant  (accessible  en  ligne)  pour  plus 
d'information sur ce concept :

« The concept of fidelityThe concept of fidelity » dans la version 2006 du manuel officiel :
http://www.sci.muni.cz/botany/juice/JUICEman_all.pdf (page 45, - pdf p. 50)

« Determination of diagnostic species with statistical fidelity measuresDetermination of diagnostic species with statistical fidelity measures  »
Chytrý, Tichý, Holt & Botta-Dukát (2002) in J.Veg.Sci 13, pp : 79-90
http://www.sci.muni.cz/botany/juice/JVS2002.pdf 
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III.F.2 Les valeurs seuils (threshold values)  

Avant de procéder à l’affichage d’un tableau synoptique, il est nécessaire 
de  préciser  un certain  nombre  de paramètres  concernant  notamment  leurs 
valeurs seuils (« threshold valuesthreshold values »). 

Pour cela, en ce qui concerne la fidélité, il faut d'abord vérifier quelques 
paramètres en suivant :  Options dans le menu File, puis cliquer sur l’onglet 
Fidelity Measures. Plusieurs informations sont fournies ou demandées.

Dans « Type of Fidelity MeasureType of Fidelity Measure » apparaît « phi coefficient » ; il s’agit du 
coefficient  proposé  et  conseillé  par  CHYTRY  et  al.  (2002)  pour  mesurer  la 
fidélité sachant que d’autres modes de calcul  peuvent  être retenus comme 
l’affiche le sous-menu déroulant.

Dans  le  cadre  « Standardisation  of  Releve  Group  SizeStandardisation  of  Releve  Group  Size »,  plusieurs 
possibilités sont offertes. En effet, les mesures de fidélité sont dépendantes de 
la taille relative des groupes de relevés. Il est donc conseillé de conserver ce 
qui est proposé par défaut (« C. The size of All groups is standardised..C. The size of All groups is standardised.. »).

Enfin, il est possible d’ajouter un test statistique en cochant « CalculateCalculate   
Fisher’s  exact  test…Fisher’s  exact  test… »  et  une  valeur  P  < …  correspondant  au  seuil  de 
probabilité que l’on désire retenir pour les valeurs de fidélités. Ce test permet 
d’éliminer comme espèces diagnostiques celles qui ne diffèrent pas (pour une 
valeur  seuil  de  fidélité,  voir  ci-après),  au  seuil  de  signification  statistique 
retenu,  d’une distribution aléatoire  dans l’ensemble des groupes de relevés 
considérés (hypothèse nulle). 

Pour  fixer  les valeurs seuils des  différents  paramètres,  il  faut  aller 
dans le menu File > Options > Synoptic Tables (on peut ouvrir aussi la 
même fenêtre à partir du menu Synoptic Table > Threshold Values).

Dans « ThresholdsThresholds » à droite sont affichés les différents paramètres :

- Fidelity :  2  valeurs  sont  proposées,  basse  (« LowerLower »)  et  haute 
(« HigherHigher »)  permettant  de  définir  des  espèces  diagnostiques  et  hautement 
diagnostiques.  Des  exemples  de  valeurs  seuils  souvent  retenues  sont 
respectivement 25 et 50 ; il suffit de préciser ces nombres en cliquant sur les 
chiffres indiqués par défaut et en les modifiant. Il est également possible de 
choisir des couleurs (cocher  Display colours) pour surlignés les valeurs de 
fidélité correspondantes aux seuils dans le tableau synoptique ; en cliquant sur 
Colour la fenêtre qui apparaît permet d’effectuer le choix souhaité ;

- Frequency : les principes sont les mêmes que pour la fidélité ; 40% et 
80% sont des valeurs fréquemment retenues. Ce paramètre est ensuite utilisé 
pour définir les espèces constantes dans un groupe de relevés ;

- Cover : idem avec des valeurs de 25% et 50%. Ce paramètre permet 
de désigner les espèces dominantes.
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REMARQUE : Les  indications  fournies  sous le  titre  « ThresholdsThresholds »  ne 
sont pas à modifier sauf si l’on désire un nombre de décimales supérieures à 
ce qui est indiqué par défaut.

« Combined  synoptic  tablesCombined  synoptic  tables » indiqué  dans  la  même  fenêtre  permet, 
quand  on  clique  sur  la  même  expression  dans  le  menu  Synoptic Table, 
d’afficher  simultanément  2  paramètres  selon  la  présentation  désirée  et 
obtenue en cochant le petit cercle correspondant. 

Ci-dessous un exemple de tableau synoptique concernant la fidélité après 
avoir procédé au tri des espèces (Sort Species in Synoptic Table dans le 
menu Synoptic Table).
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III.F.3 Définition des espèces diagnostiques, constantes et   
dominantes

Comme il a été dit au début, une étape importante dans la démarche du 
phytosociologue,  est  la  définition  de  différentes  catégories  d’espèces 
(diagnostiques,  constantes  et  dominantes).  Pour  cela  il  faut  procéder  à 
l’analyse des colonnes du tableau synoptique.

Analyse des colonnes dans la table synoptique
Après avoir cliqué sur Analysis of columns of Synoptic TableAnalysis of columns of Synoptic Table dans 

le menu Synoptic TableSynoptic Table, la fenêtre suivante apparaît à l’écran : 

Elle  présente  3  colonnes  relatives  respectivement  à  la  fidélité,  à  la 
fréquence et au recouvrement. En face de ces paramètres sont indiquées les 
valeurs seuils qui ont été retenues (à vérifier si elles correspondent bien aux 
choix initiaux, sinon se reporter au titre précédent : III.F.2.     Les valeurs seuils  . 

Au bas de la colonne « Dominant speciesDominant species » est indiqué  Minimum freq.Minimum freq.  
((          11          --          100100          %)%)          : 0 : 0     , il convient d’indiquer là un pourcentage de relevés où l’on 
peut rencontrer des espèces présentant un recouvrement supérieur à la valeur 
seuil, par défaut 25 %. Sont en principe retenus 5 voire plutôt 10 %. 
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Pour  que  les  espèces  s’affichent  dans  chacune  des  colonnes,  il  faut 

cliquer sur le bouton RefreshRefresh (sur la figure suivante : ).  L’opération est à 
répéter pour chacune des colonnes du tableau synoptique en agissant sur la 

barre ColumnColumn située au bas de la fenêtre (en ).
La figure suivante donne un exemple des résultats obtenus dans le cas 

de la colonne 2 du tableau synoptique (la colonne 1 composée uniquement de 
2 relevés mérite d’être écartée au moins provisoirement).

A noter encore que les noms des espèces sont précédés par les valeurs 
du  paramètre  concerné  et  suivi  par  un  nombre  entre  parenthèses 
correspondant à la strate de végétation (« LayerLayer ») non renseignée dans cet 
exemple -d'où les valeurs de (0)- et le cas échéant par une abréviation :  Dm 
pour dominante , Dg pour diagnostique, C pour constante, ceci lorsque la case 
Show referencesShow references a été coché. Par ailleurs, il est possible de marquer avec une 
couleur dans le tableau synoptique l’ensemble des espèces d’une colonne (ou 
une partie) en les sélectionnant avec la souris puis en cliquant sur le bouton 
Mark in the tableMark in the table.
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Enfin,  en cliquant sur  ExportExport on obtient une présentation synthétique 
des informations obtenues comme le montre la figure suivante :

En cliquant  à nouveau sur  ExportExport (en bas à droite  de cette nouvelle 
fenêtre)  pour  une colonne,  ou  en cliquant  sur  Export Clusters 1-Export Clusters 1-    nn     pour 
l’ensemble  des  colonnes  du  tableau  synoptique,  les  données  sont 
sauvegardées dans le  fichier  d'export  au format RTF,  au préalable  introduit 
dans  le  dossier  de  travail  via  le  menu  File > Export > Current *.RTFFile > Export > Current *.RTF  
filefile          ::          ......          .

III.F.4 “Average Value of Frequency Columns in Synoptic Table”  

Cliquer sur cette fonction (pour rappel : on est dans le menu Synoptic tableSynoptic table) 
ouvre une fenêtre qui  indique les  valeurs  moyennes de chaque colonne du 
tableau synoptique pour le paramètre retenu (fréquence relative, fidélité, etc.). 
Ces valeurs peuvent être copiées dans le presse-papier (Copy to clipboardCopy to clipboard). 
Il  est  également  possible  en  cochant  l’option  qui  est  offerte  au  bas  de  la 
fenêtre et en cliquant sur le bouton  RefreshRefresh d’afficher en « Short HeadersShort Headers » 
(quand on revient au tableau analytique) les valeurs moyennes par relevé.
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III.F.5 “No. of Species in Columns of Synoptic Table”  

Cette fonction  permet d’afficher dans une nouvelle  fenêtre le  nombre 
d’espèces pouvant être recensé dans chaque colonne d’un tableau synoptique. 
Pour  la  fidélité,  seules  les  espèces  correspondant  aux  valeurs  seuils  sont 
comptées.

III.F.6 “Uniqueness ” et “Crispness of Classification”  

Ces deux fonctions ne sont pas décrites dans cette version du tutoriel car 
elles  sont  essentiellement  utilisées  dans  le  cadre  de  la  classification 
hiérarchique des unités de végétation (alliance, ordre, classe), ce qui nécessite 
théoriquement de disposer d’un très grand nombre de relevés correspondant 
aux différents  types de végétation pouvant être rencontrés à l’échelle  d’un 
territoire relativement vaste, tel régional ou plutôt national. Ces fonctions sont 
donc pertinentes pour l’élaboration des synsystèmes phytosociologiques.

III.F.7 “Compare Two Synoptic Tables”  

Dans  la  mesure  où  différents  modes  de  classification  (classifications 
agrégatives, divisives…) d’un même tableau brut de données peuvent conduire 
à des résultats  différents,  il  peut être  utile  de les  comparer.  Cette fonction 
permet  de  calculer  de  façon  croisée  les  distances  euclidiennes  entre  les 
colonnes  de  deux  tableaux  synoptiques  (seulement  pour  les  fréquences 
relatives et les fidélités) et d’indiquer un pourcentage de similarité entre les 
deux tableaux. 

Pour utiliser cette fonction il faut procéder en plusieurs étapes :
1- Afficher un premier tableau synoptique obtenu à partir d’un premier mode 

de classification ;
2- Cliquer  sur  Compare  Two  Synoptic  TablesCompare  Two  Synoptic  Tables puis  sur  Save  Image  ofSave  Image  of  
Synoptique TableSynoptique Table pour sauvegarder le tableau dans un fichier de travail ;
3- Ouvrir le tableau de données pour le traiter avec une deuxième modalité de 

classification ; afficher le tableau synoptique correspondant (pour le même 
paramètre que le premier) ;

4- Cliquer à nouveau sur Compare Two Synoptic TablesCompare Two Synoptic Tables puis sur Load ImageLoad Image  
And CompareAnd Compare ; 

La fenêtre qui s’ouvre indique le pourcentage de similarité entre les deux 
tableaux, le détail des calculs étant fourni dans le presse-papier.
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III.F.8 “Merge Two Nearest Columns”  

En cliquant sur cette fonction, JUICE propose de réunir deux colonnes du 
tableau synoptique en indiquant les valeurs moyennes de fréquences relatives 
ou de fidélités ou les distances euclidiennes pour deux groupes de relevés pour 
lesquels  ces  valeurs  sont  les  plus  proches  en  considérant  l’ensemble  du 
tableau. Il ne s’agit que d’une proposition et la décision dépend des valeurs 
calculées. Compte tenu que pour les distances euclidiennes, la fenêtre précise 
que toutes les valeurs sont copiées dans le Presse-Papier (« All ED values wereAll ED values were   
copied  into  the  Clipboardcopied  into  the  Clipboard »)  la  décision  peut  être  facilitée  par  un  examen 
attentif des résultats des différents calculs.

III.F.9 “Threshold Values  ”  

Cette  fonction  permet  de  préciser  les  valeurs  seuils  des  différents 
paramètres et,  comme il  a été indiqué au titre  III.F.2.  Les valeurs seuils,  la 
fenêtre qui s’ouvre est identique à celle obtenue quand on utilise la fonction : 
Menu File > Options > Synoptic tablesFile > Options > Synoptic tables.
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III.G Menu «     Analysis     »  

Ce menu permet la mise en œuvre d’analyses  numériques de tableaux 
phytosociologiques. Outre les opérations de classification et d’ordination des 
relevés,  JUICE  propose  des  méthodes  pour  procéder  au  rattachement  de 
relevés non classés  à  des  unités  de  classification  définies  au préalable.  Ce 
menu permet aussi le calcul de divers indices de similarité et de diversité.

III.G.1 «     TWINSPAN (Hill 1979)     »  

Le menu  Analysis > TWINSPANAnalysis > TWINSPAN offre  deux options :  TWINSPAN (HillTWINSPAN (Hill  
1979)1979) et  Modified TWINSPAN Classification (Rolecek et al. 2009)Modified TWINSPAN Classification (Rolecek et al. 2009). 
Dans cette version du tutoriel,  seule la première option est décrite car elle 
correspond  à  une  méthode  très  classique  de  classification  des  relevés 
phytosociologiques,  la  seconde, très récente,  nécessitant un développement 
théorique assez conséquent.

NB : Vérifiez  si  TWINSPAN est  automatiquement  lié  à  JUICE  dans  le 
menu FileFile          >>          OptionsOptions    , puis à l’onglet External Program PathsExternal Program Paths, sinon il faut 
préciser le chemin.

Twinspan est le sigle de “Two-way  Indicator  Species  Analysis” :  “Two-
way Analysis” car la classification concerne à la fois les relevés et les espèces, 
« Indicator Species » car l’analyse est fondée sur une analyse multivariée des 
correspondances  qui  sépare  des  groupes  de  relevés  composés  d’espèces 
censées correspondre à des conditions écologiques particulières.

Le choix de cette option provoque l’ouverture de la fenêtre suivante :

- ColourColour     : la classification porte sur les relevés correspondant à la couleur 
indiquée.  Ainsi,  si  aucun  des  relevés  n’a  été  coloré  (whitewhite)  la 
classification concernera l’ensemble du tableau. Par le menu déroulant 

Page 85 / 97



de « ColourColour »  et  le  choix  d’une couleur particulière,  il  est  possible  de 
sélectionner  une  partie  seulement  des  relevés  et  de  procéder  à  une 
analyse partielle du tableau.

- Pseudospecies cut levelsPseudospecies cut levels      est le nombre de niveaux de divisions des 
pourcentages de l’échelle d’abondance-dominance des espèces et 

- Values of cut levelsValues of cut levels     sont les valeurs de pourcentages correspondant 
aux niveaux de divisions, valeurs à séparer par des espaces.

Pour comprendre la signification de ces paramètres il faut savoir que le 
principe de l’analyse repose sur des données qualitatives en présence-absence. 
De manière à prendre en considération les données quantitatives d’abondance-
dominance, le concept de « pseudospeciespseudospecies » a été introduit dans Twinspan. En 
supposant  que  les  valeurs  de  0,  5 et  25 soient  les  valeurs  retenues  de 
pourcentages de « cut levelscut levels », et en prenant l’exemple d’une espèce x avec le 
coefficient 2 (correspondant à un pourcentage de recouvrement moyen de 13% 
dans l’échelle  choisie :  ici  Braun Blanquet  Old ScaleBraun Blanquet  Old Scale),   cette  espèce x sera 
comptabilisée en présence dans chacune des classes de valeurs, [ > 0 ]» et 
[ > 5 ] mais notée absente pour [ > 25 ]. Cela revient à la reconstruction d’un 
tableau brut  (en  présence-absence)  où l’espèce x est  notée pour  le  même 
relevé  dans  deux  lignes  avec  x1  et  x2  (donc  des  « fausses  espèces »  ou 
pseudospeciespseudospecies). Dans ce cas de figure, le chiffre affiché dans la fenêtre des 
paramètres de Twinspan serait de 3 pour « Pseudospecies cut levelsPseudospecies cut levels » et 0, 5, 
25 pour les « Values of cut levelsValues of cut levels ». Ce sont les valeurs proposées par défaut 
mais il est évidemment possible de les modifier. 

- Minimum group sizeMinimum group size     est le nombre minimum de relevés entrant dans la 
composition d’une division de la classification. 

- Maximum level of divisionsMaximum level of divisions     : twinspan procédant à une classification 
hiérarchique des données, il  est possible de fixer un niveau donné de 
divisions. Le nombre maximum proposé par JUICE est de 6 compte tenu 
du nombre de caractères pouvant être affiché dans la zone T : « HeaderHeader   
datadata ». 

Remarque :
Il est conseillé de retenir cette valeur de 6 car il est toujours possible à 
l’issue de l’analyse de revenir à un nombre moindre de divisions en  
modifiant le chiffre indiqué à droite de la barre des menus près de  
« Separator hierarchySeparator hierarchy ». Le choix de la valeur est très dépendant de la 
taille du tableau mais, dans beaucoup de situations, la valeur de 3 est 
très satisfaisante au moins dans une première phase d’analyse.

- Species  sortingSpecies  sorting     En  cochant cette  option,  les  espèces  seront 
réarrangées en fonction de leur répartition dans les groupes de relevés.

- Make separatorsMake separators     En cochant cette option les groupes de relevés issus 
de  la  classification  seront  séparés  par  des  traits  verticaux  selon  des 
figurés  dépendant  du  niveau  de  division.  Si,  toutefois,  « SeparatorSeparator   
hierarchyhierarchy »  n’est  pas  coché  dans  la  barre  des  menus,  tous  les 
séparateurs seront des traits continus.
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- RUN TWINSPANRUN TWINSPAN     permet de lancer l’analyse.

Le tableau initialement brut est réorganisé en mettant en évidence des 
groupes de relevés et les espèces sont réarrangées. Les groupes de relevés 
sont caractérisés par des chiffres différents apparaissant en « Header dataHeader data » et 
sont distingués par les séparateurs si cette option a été retenue. En agissant 
sur le nombre de divisions (bouton à droite de « Separator hierarchySeparator hierarchy » dans la 
barre d'outils) il est possible d’obtenir différentes partitions du tableau.

La  figure  suivante  présente  un  exemple  de  résultat  obtenu  (tableau  
partiel) avec un niveau 2 pour les divisions.

Pour revenir à la numérotation initiale des relevés il  faut aller dans le 
menu  HeadHead et  cliquer  sur  Initial  Entry  NumberInitial  Entry  Number ou  Original  NumberOriginal  Number  
(‘Releve number’)(‘Releve number’) qui  correspond  à  la  numérotation  de  TURBOVEG  si  le 
tableau a été importé à partir de ce logiciel.

Après cette première phase d’analyse qui a permis de procéder à une 
classification des relevés, plusieurs prolongements sont possibles en fonction 
des types d’informations que l’on désire obtenir :

- compléter l’analyse en ayant recours à des méthodes d’ordination des 
relevés par des analyses  multivariées  (sous-menu  Ordinations > R-Ordinations > R-
PROJECTPROJECT du menu AnalysisAnalysis - voir le titre suivant : III.G.2. Ordinations) ;
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- approfondir  l’analyse  par  la  définition  de  catégories  d’espèces 
(diagnostiques, constantes, dominantes) ; il faut alors travailler avec des 
tableaux synoptiques et pour cela aller dans le menu Synoptic TableSynoptic Table - 
voir le titre : III.F.3. Espèces Dg, C et Dm ;

- engager une démarche visant au rattachement de relevés à des unités 
phytosociologiques  définies  au  préalable  (menus  AnalysisAnalysis          >>          COKTAILCOKTAIL      
GroupsGroups,  >  Expert  System>  Expert  System et  >  Matching  to  WHITE  Relevés>  Matching  to  WHITE  Relevés  
notamment). 

REMARQUES 
1- D’autres  fonctions  disponibles  dans  le  menu  « Analysis »  sont 

présentées dans le cadre d’une approche complémentaire ;

2- Le menu « Analysis » offre d’autres possibilités de classification (ou de 
« clusteringclustering ») (PC-ORD, SYN-TAX… ) et d’ordination (CANOCO) qui ne 
sont  pas  retenues  dans  ce  tutoriel  car  il  s’agit  soit  de  logiciels 
commerciaux soit de logiciels moins faciles à utiliser que Twinspan et 
R-PROJECT. Ce tutoriel se limite à ce qui est librement accessible avec 
JUICE.

3- Les sous-menus relatifs à OPTIMCLASS Analysis ne sont pas non plus 
présentés car ils nécessitent la possession de PC-ORD. 
Il s’agit toutefois  d’analyses très intéressantes, leur objectif étant de 
déterminer le nombre optimal de groupes de relevés en comparant les 
résultats de différentes modalités de calculs. 

III.G.2 «     Ordinations     »  

L’option retenue est « R-PROJECT » compte tenu de la remarque 2 ci-
dessus.

Le recours à des méthodes d’ordinations permet de vérifier la pertinence 
des résultats issus de la classification réalisée avec Twinspan mais aussi de 
procéder  à  leur  interprétation  écologique  dans  la  mesure  où  l’on  dispose 
d’informations à ce sujet.  Par exemple,  les indices d’Ellenberg peuvent être 
utilisés dans ce cadre.

Pour  mettre  en  œuvre  ces  analyses  avec  JUICE,  il  est  nécessaire  de 
disposer du logiciel R-PROJECT installé sur son ordinateur. Dans JUICE suivre le 
menu :  Analysis > Ordinations > R-PROJECT > DCA analysis > ScriptAnalysis > Ordinations > R-PROJECT > DCA analysis > Script  
updateupdate et cliquer sur : Installation of R librariesInstallation of R libraries.

Pour plus d'informations se reporter à :
http://sci.muni.cz/botany/zeleny/install-ord.php 
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Remarque :
Enfin, ne pas oublier de vérifier si R-PROJECT a été automatiquement lié 
à JUICE dans le menu File > OptionsFile > Options puis l’onglet External ProgramExternal Program  
PathsPaths, sinon il faut préciser le chemin à cet endroit.

Plusieurs possibilités d’analyse sont offertes :
• DCA (Detrended Correspondence Analysis),
• PCA (Principal Component Analysis)
• NMDS (Non-metric Multidimensional Scaling).

Remarque :
Voir les ouvrages spécialisés pour des informations complémentaires sur 
ces analyses.

La DCA ou Analyse détendancée des correspondances est l’équivalent 
d’une analyse classique des correspondances avec cependant des différences 
permettant notamment de supprimer l’effet Gutman. Ce tutoriel a retenu ce 
type d’analyse à titre d’exemple.

2.a « DCA Analysis »

Après avoir cliqué sur cette option, la fenêtre suivante apparaît à l’écran :
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Dans l’onglet Graph ParametersGraph Parameters il est possible de préciser les conditions 
de réalisation de l’analyse. L’exemple présenté montre que les relevés soumis 
à  l’analyse   n’ont  pas  été  colorés  de  façon  particulière  (« whitewhite »),  qu’une 
projection en 3D a été choisie (donc avec 3 axes), que seule la projection des 
relevés (« SitesSites ») a été retenue avec mention « with all labelswith all labels » (c’est-à-dire 
tous  les  numéros  de  relevés),  que  les  groupes  de  relevés  soient  délimités 
(« EnvelopesEnvelopes ») et que les centres de gravité (« CentroidsCentroids ») de ces groupes de 
relevés soient positionnés dans la projection.

NB : Pour que les enveloppes et les centroïdes apparaissent dans la 
projection, il est nécessaire de réaliser cette analyse à partir d’un tableau issu 

d’une classification avec des séparateurs (p.e. Twinspan).

Après avoir cliqué sur FinishFinish, la figure suivante est obtenue :

On retrouve bien les 4 groupes de relevés distingués par Twinspan (le 
groupe  1  avec  2  relevés  seulement)  et  relativement  bien  séparés  d’autant 
qu’en  faisant  varier  l’orientation  de  la  figure  (à  l’aide  de  la  souris  ou  en 
agissant sur les flèches de Figure rotationFigure rotation dans la petite fenêtre qui jouxte 
le  plan  de  projection)  on  note  qu’il  n’y  a  pas  d’importantes  zones  de 
chevauchement des groupes de relevés. Cette petite fenêtre permet aussi une 
rotation continue du plan de projection (cliquer  Continue rotatingContinue rotating) dont on 
peut  faire  varier  la  vitesse  (SpeedSpeed)  et  l'échelle  (ScaleScale).  Il  est  également 
possible de copier une image (Take a snapshotTake a snapshot) et d’afficher les informations 
relatives à l’analyse (Show summaryShow summary).
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Si  l’on  dispose  de données  relatives  aux  variables  environnementales 
comme par exemple les calculs obtenus avec les indices d’Ellenberg (voir menu 
Indicator valuesIndicator values)  il  est  possible  d’afficher  sur  le  plan  de  projection  les 
vecteurs relatifs à ces variables et ainsi donner une signification aux axes du 
plan de projection comme le montre la figure suivante. Pour cela il faut dans la 
fenêtre de R-PROJECT cliquer sur l’onglet Environnemental VariablesEnvironnemental Variables, cocher 
dans  « Environnemental  vectorsEnvironnemental  vectors »  les  variables  étudiées  (ici :  Salinité,  pH, 
« moisturemoisture » (NdT : humidité) et « nutrientsnutrients » (NdT : nutriments)) et cliquer sur 
FinishFinish.

Les autres analyses offertes par R-PROJECT fonctionnent selon les mêmes 
principes  et  sont  à  choisir  en  fonction  des  problématiques  que  l’on  désire 
aborder.
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III.G.3 «     Co-occuring species     »  

Cette  fonction  permet  de  lister  les  espèces  qui  sont  associées  à  une 
espèce préalablement choisie en fonction de leurs fréquences d’occurrence.

Avant  de  mettre  en  œuvre  cette  fonction  il  convient  de  choisir  une 
espèce (pour cela il faut cliquer dans le tableau sur l’espèce choisie et son nom 
apparaît alors en bas à gauche de la fenêtre principale de JUICE) pour laquelle 
on désire connaitre les espèces qui lui sont associées.

En cliquant ensuite sur la fonction, la fenêtre suivante apparaît.

Le nom de l’espèce choisie figure dans le coin supérieur gauche avec le 
nombre  de  relevés  où  elle  est  présente.  La  liste  des  espèces  les  plus 
fréquemment associées est triée dans un ordre décroissant en fonction de leur 
fréquence dans les relevés où l’espèce choisie est présente.

Ainsi, la première colonne indique le pourcentage de relevés où l’espèce 
choisie  contient  également  l’espèce  listée.  Par  exemple,  dans  les  résultats 
affichés dans la fenêtre,  Agrostis stolonifera est présent dans tous les relevés 
où se trouve aussi  Mentha pulegium s. pulegium (100.00). Après le nom de 
l’espèce, la colonne suivante indique la strate (ici : 0 – car non renseignée) puis 
2 chiffres, le premier (ici : 107 pour Agrostis stolonifera) correspond au nombre 
de relevés où se trouve l’espèce dans l’ensemble du tableau, le deuxième au 
nombre  de  relevés  (ici :  9)  où  l’espèce  coexiste  avec  l’espèce  choisie  (ici 
Mentha pulegium s. pulegium).
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Par ailleurs, il est possible de colorier dans le tableau les espèces les plus 
fréquemment associées (en décidant d’une valeur seuil de pourcentage). Pour 
cela il faut sélectionner avec la souris les espèces correspondant aux valeurs 
retenues, choisir une couleur (par exemple ici  « redred ») puis cliquer sur  MarkMark  
selected species in the tableselected species in the table. Par la suite, ces espèces coloriées peuvent 
être regroupées dans le tableau un utilisant le menu  SortingSorting et la fonction 
Move  speciesMove  species ou  en  cliquant  sur  le  bouton  correspondant  dans  la  barre 
d'outils :
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III.G.4 «     Interspecific Associations     »  

Cette fonction est relativement voisine de la précédente mais elle est 
fondée sur l’indice de fidélité (voir à ce sujet le titre III.F.1), ce qui évidemment 
ne donne pas les mêmes résultats.

La  mesure  de  la  fidélité  est  calculée  pour  chaque  paire  d’espèces 
combinant l’espèce choisie et toutes les autres espèces du tableau.

Comme pour la fonction « Co-occuring SpeciesCo-occuring Species » développée ci-avant, il 
convient  d’abord  de choisir  une  espèce  puis  de  cliquer  sur  InterspecificInterspecific  
AssociationsAssociations.

La fenêtre suivante apparaît à l’écran.

Elle  est  composée  en  deux  parties :  la  supérieure  correspondant  aux 
espèces positivement  associées  à  l’espèce choisie  sur  le  critère  de fidélité, 
l’inférieure, aux espèces négativement associées.

Les informations fournies et les possibilités de coloriage des espèces sont 
équivalentes  à  la  fonction  « Co-occuring  SpeciesCo-occuring  Species »  avec  cependant  une 
différence  importante :  les  valeurs  de  la  première  colonne  correspondent  à 
l’indice de fidélité.
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Annexe I - État des citations en 2011

Pour comparaison, l'état des citations en 2008 était le suivant :
• sur http://apps.isiknowledge.com/ :79 citations enregistrées
• sur http://scholar.google.com/: 95 citations enregistrées

Source : BECK (2008)

Page 96 / 97

http://scholar.google.com/
http://apps.isiknowledge.com/


Annexe II – Script d'installation de JUICE sous Linux via PlayOnLinux

Script rédigé par Sylvain POULAIN et adapté par Florent BECK :
-------------------------------------------------------------------------------------------------
= copiez-collez le texte suivant dans un fichier texte ===========
= le nom n'a pas d'importance, il ne doit pas porter d'extension =

#!/bin/bash 
# Date : (2010-01-26 11-30) 
# Last revision : (2010-08-08 12-07) 
# Wine version used : N/A 
# Distribution used to test : Linux/Ubuntu 10.04 Lucid Lynx 
# Script's Authors : Sylvain POULAIN, Florent BECK 

# start PlayOnLinux (afterwards called POL) 
if [ "$PLAYONLINUX" = "" ] 
then 
exit 0 
fi 

source "$PLAYONLINUX/lib/sources" 

# open a POL Window 
POL_SetupWindow_Init 

# Give informations about the software 
POL_SetupWindow_presentation "JUICE" "Lubomír TICHÝ" 

"http://www.sci.muni.cz/botany/juice/index.htm" "Sylvain Poulain 
and Florent Beck" "JUICE" 

# Create (or update) a wine prefix for JUICE 
select_prefixe "$REPERTOIRE/wineprefix/JUICE/" 
POL_SetupWindow_prefixcreate 

# Download the executable file for JUICE installation from the internet 
POL_SetupWindow_download "Please wait while JUICE is downloaded" "JUICE" 

"http://www.sci.muni.cz/botany/juice/F7_0_17/JUICE_Setup.exe" 
 
# tell the user JUICE will being installed and execute the setup file 
POL_SetupWindow_wait_next_signal "Please wait while JUICE is installed" 

"JUICE" 
wine "JUICE_Setup.exe" 
POL_SetupWindow_detect_exit 

POL_SetupWindow_reboot 

# Ask the user for creating shortcuts 
POL_SetupWindow_make_shortcut "JUICE" "Program Files/JUICE 7.0/" 

"juice.exe" "JUICE.xpm" "JUICE" 
POL_SetupWindow_message "JUICE has been successfully installed" "JUICE" 
POL_SetupWindow_Close 
exit
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